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FCC Information to User

Safety and Care Instructions

No matter what your level of experience with computers, please make sure you
read the safety and care instructions. This information can help protect you and

your computer from possible harm.

Radio and television interference

Warning: Use the specified shielded power cord and shielded signal cables
with this computer, so as not to interfere with radio and television reception. If
you use other cables, it may cause interference with radio and television

reception.

This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does not cause harmful interference to radio or
television reception, which can be determined by turning the equipment off
and on, the user is encourage to try to correct the interference by one or more

of the following measures:
e  Reorient or relocate the receiving antenna
e Increase the separation between the device and receiver

e  Connect the device into an outlet on a circuit different from that to which

the receiver is connected.

e Consult the dealer or an expetienced radio/television technician for help.



You may find helpful the following booklet, prepared by the Federal
Communications Commission: Interference Handbook (stock number 004-
000-00345-4). This booklet is available from the U.S. Government Printing
Office, Washington, DC20402

Warning: The user must not modify or change this computer without

approval. Modification could void authority to this equipment.

Canadian Department of Communications Compliance
Statement

This Class B digital apparatus meets all requirement of the Canadian

Interference-Causing Equipment Regulations.

Shielded Cables Notice

All connections to other computing devices must be made using shielded

cables to maintain compliance with FCC regulations.

Peripheral Devices Notice

Only petipherals (input/output devices, terminals, printers, etc) certified to
comply with Class B limits may be attached to this equipment. Operation with
non-certified peripherals is likely to result in interference to radio and TV

reception.

CD-ROM Notice
The CD-ROM is a Class One Laser Product.

Caution

Changes or modifications not expressly approved by the manufacturer may
void the user’s authority, which is granted by the Federal Communications

Commission, to operate this computer.



Use Conditions

This part complies with Part 15 of the FCC Rules. Operation is subject to the
following conditions: (1) this device may not cause harmful interference, and
(2) this device must accept any interference received, including interference

that may cause undesired operation.
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1 Introduction

Your Notebook PC is a fully IBM compatible
portable personal computer. With the latest features
in mobile computing and multimedia technology, this

notebook makes a natural traveling companion.

Lightweight and compact, your Notebook PC runs on
a whole wide range of general business, personal
productivity, entertainment, and professional
applications. It is ideal for use in the office, at home,

and on the road.

With its all-in-one design, full functionality is built-in
with no need to change external devices. Your
Notebook PC makes an ideal choice for use in the
office, the schoolroom, at home, on the road and all

other occasions.
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1.1 Feature Highlight

Before we go to identify each part of your Notebook PC, we will first

introduce you to other notable features of your computer.

Processing Unit

¢ Your notebook runs on Intel WPGA2 Mobile Pentium IIT microprocessor,
featured with SpeedStep technology, with integrated 256KB 1.2 Cache; or
Intel pPGA2 Mobile Celeron microprocessor, with integrated 128KB 1.2
Cache. Check with your dealer on the CPU type and speed.

e Fully compatible with an entite library of PC software based on operating
systems such as MS-DOS, Windows 98/Me, and Windows N'T/2000. It

also runs on future versions of Windows.

Memory

This notebook provides two memory slots for installing 144-pin SODIMM
modules up to 256MB using 64MB, or 128MB SDRAM modules.

PCMCIA

Provides two PCMCIA slots that allow you to insert either two Type II or one
Type III cards.

AGP Local Bus Architecture

e AGP 2X video local bus and 2D/3D Graphic Engine with 8MB VRAM.




Introduction 1

PCI Local Bus Architecture

32-bit PCI Enhanced IDE optimizes the data transfer between the CPU
and hatd disk drives. Support ultra DMA33/66 PIO Mode up to PIO
Mode 4, bus mastering for LBA Scheme.

32-bit PCMCIA CardBus PCI technology that is also backward compatible
with 16-bit PC cards.

Audio System

Full-duplex 16-bit stereo audio system with wavetable function and Plug-and-

Play features. Sound Blaster and Sound Blaster Pro compatible.

Flash BIOS allows you to easily upgrade the System BIOS using the Phoenix

Flash utility program.

Power and System Management

Integrated SMM (System Management Mode) on system chipset that shuts
down components not in use to reduce power consumption. To execute
power management, you can set up the parameter in power options

properties by pointing your mouse to Control Panel.

Auto Suspend hot-key allows you to suspend the system operation

instantly and resume at the press of the power button.

System Password for User and Supervisor included on the BIOS SETUP

Program to protect unauthorized use of your computer.

1-3
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1.2 Unpacking the Computer
Your computer comes securely packaged in a sturdy cardboard shipping
carton. Upon receiving your computer, open the carton and carefully remove

the contents. In addition to this User Guide, the shipping carton should also

contain the following items:

M The Notebook Computer

M Anac Adapter and AC Power Cord
| Li-Ton/Ni-MH Battery Pack

M Utility Diskettes/CD

|Zl Hardcopy User Guide/E-book

M Quick Setup Manual

Carefully inspect each component to make sure that nothing is missing and/or
damaged. If any of these items is missing or damaged, notify your dealer
immediately. Be sure to save the shipping materials and the carton in case you
need to ship the computer or if you plan to store the computer away sometime

in the future.
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1.3 The Inside of the Notebook

The notebook computer is compact with features on every side. First, look at

the inside of the system. The following sections describe inside features.

0. Color LCD Display 0. Keyboard

0. Integrated Microphone 0. Power Status LED Indicator
0. Status LED Indicator 0. Easy Buttons

0. Power On/Resume Button 0. Touchpad Pointing Device

e  Color LCD Display
The notebook computer comes with a color LCD that you can adjust for a
comfortable viewing position. The LCD can be a 12.1” TFT (Thin Film
Transistor) color LVDS with 800x600 SVGA (Super Video Graphics
Array) resolution panels, or 13.3” or 14.1” TFT color LVDS with
1024x768 XGA (Extended Graphics Array) resolution panels. The

features of the Color LCD Display are summarized as follows:

O TEFT color LVDS with 800x600 SVGA or 1024x768 XGA resolution

panels.

1-5
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0  Capable of displaying 16M colors (32-bit true color) on either SVGA
or XGA LVDS panels.

0  LVDS display control hot-keys allows you to adjust the brightness of
the LCD.

0  Simultaneous display capability for LCD and external desktop
computer monitor.

0  LCD display can be upgraded from 12.1” TFT to 13.3” or 14.1”
TFT.

Keyboard

0  Standard QWERTY-key layout and full-sized 87/88 keys keyboard
with Windows system hot-keys, embedded numerickeypad, 7 hot
keys, inverted “I”” cursor arrow keys, and separate page screen
control keys.

O  Wide extra space below the keyboard panel for your wrist or palm to

sit-on comfortably during typing.

Integrated Microphone

Integrated mono microphone for instant voice recording and simultaneous

voice conversation.

Power Status LED Indicator

Keeps you informed of your notebook computet’s current power status.

Descriptions of the status icons appear in the latter part of this section.

Status LED Indicator

Keeps you informed of your notebook computet’s current operating

status. Descriptions of the status icons appear in the latter part of this

section.
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Easy Buttons

There are four easy buttons, two use for accessing Internet and e-mail
functions instantly and easily, the other two let you define certain
functions by yourself. Descriptions of the easy buttons appear in the latter

part of this section.

Power On/Resume Button
Switches the computer power on and off, or resumes whenever it is in

Suspend mode.

Touchpad Pointing Device

Microsoft and IBM PS/2 mouse compatible with three select buttons as
one Scroll button and two Touchpad click buttons. These three buttons
array below the Glide pad. The middle one is located with the Scroll
button that lets you execute the scroll page function. The two click
buttons located at each side support tapping selection and dragging
functions. These buttons work like a standard computer mouse. Simply
move your fingertip over the Glide Pad to control the position of the

cursor. Use the selection buttons below the Glide Pad to select menu

items.
POWER STATUS ICONS
7
®
0. Power Indicator a. Battery Charging LED
0. Mail LED

17
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e  Power Indicator
Lets you know that power to the system is turned on. This LED is
positioned so that you can see the power state whether the LVDS panel is

opened or closed.

O  Lights green when the system is powered on using the AC adapter or

battery.

O  Lights green blinking when in Suspend to RAM (or Suspend to Disk
if you already created Save to Disk partition in HDD by using
PHDISK utility in the MS-DOS) mode and critically low battery
power. We strongly recommend that users create the partition "Save
to Disk" as this will prevent your data from loss when power is

critically low.

e  Battery Charging LED
Lights to indicate battery in charging status.

0  Lights green to indicate that the battery is in charging.

O  Lights off to indicate the battery is fully charged or no battery

installed.

e Mail LED

Lights green to indicate that a new mail is arrived.

The notebook computer uses status lights marked with icons to communicate

system status. See the following figure and list for each icon’s meaning.

1-8
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STATUS LED ICONS

The Status LED Panel keeps you informed of the notebook’s current operating
status. Each LED is marked with an icon to designate the system status.

O @ @ ©

. Drive Access 0. Diskette Drive Access
a. Caps Lock 0. Scroll Lock

0. Num Lock
Status LED Icons

e Drive Access
When LED in green light indicates that the system is accessing either the
Hard Disk or CD-ROM/DVD-ROM.

e Diskette Drive Access
When LED in green light indicates that the system is accessing data from
or is retrieving data to the floppy diskette drive.

e CapsLock
When LED in green light indicates that the Caps Lock key on the
keyboard is activated. When activated, all alphabet keys typed in will be in

uppercase or capital letters.

1-9
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e Scroll Lock
When LED in green indicates that the Scroll Lock key on the keyboard is
activated. The Scroll Lock key has different functions depending on the

software you are using.

e Num Lock
When LED in green light indicates that the Num Lock key on the
keyboard is activated. When activated, the embedded numeric keypad will
be enabled.

THE FUNCTION OF EASY BUTTONS

&2 & N
0. E-Mail Button 0. Internet Button
0. User-Defined Button 0. User-Defined Button

e  E-mail Button
This is the most convenient way to access the outlook utility just by
pressing this button. You can omit several procedures in entering into

Outlook envitonment.

e Internet Button
This technology is designed specifically for providing a very convenient
way in connecting Internet only by pressing Internet button as shown in
the graphics. For more understanding and interesting, you can refer
Section 2.5 to recognize the driver installation procedures in activating

Internet button.
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e  User-Defined Button

You can define the specific function by yourself to active the program.

1.4 The Front Side of the Notebook

0. O. Built-in Stereo Speakers 0. Lock Switch

0. Rewind Button 0. Cover Switch
0. Audio DJ Display 0. Forward Button
0. Stop Button 0. Play Button

e  Built-in Stereo Speakers
Integrated left and right mini stereo speakers for sound and audio output

for your multimedia presentations or listening pleasure.

e Lock Switch
Use this switch to lock the status of your Audio DJ. If you lock this switch
when the music is playing, the music will continue to play no matter what
button is pressed. Audio DJ will not allow it to activate. The function of

this switch is to prevent you from touching any button accidentally.

e  Rewind Button
Press the button for reverting to previous music. Press and hold this
button to fast rewind the audio CD
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1.5

e Cover Switch
The cover (LCD panel) is locked when it is closed. Slide the button right

aside to release the latch for opening the cover of the computer.

e Audio DJ Display

The display shows the number of the music currently playing

e  Forward Button
Press the button for playing the next music. Press and hold this button to
fast forward the audio CD

e  Stop Button
Press the button to stop the music and power off the audio DJ

simultaneously

e  Play Button

Press the button to power on the audio D] with starting to play music

L[] The function of Audio DJ can be workable either in Windows system or
operate it without powering on the computer. For execute this function, you
should first install the EZsystem driver. Please refer to Section 5 of Chapter
2 for installation procedures. However, if your OS is Windows 98, you
should download and install the "Windows Media Player 7" from

Microsoft's Website to activate this function.

The Rear Side of the Notebook

You’ll find system portts for connecting optional devices (like a printer or
external monitor) to the back of your notebook computer. The ports are

described after the figure.
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060 6 0o © 0 |

0. AC Power Port 0. PS/2 Port 0. USB Port

0. LAN Port 0. Modem Port . 1394 Port

0. COM Port 0. Print Port ©. Air Inhalant

©. CRT Port ®. TV Port ®. USB Port
AC Power Port

Lets you connect the AC power adapter in supplying continuous power to

your notebook and recharging the battery.

PS/2 Port

Lets you connect an external PS/2-style mouse, PS/2-style keyboard, or
PS/2-style numeric keypad to the system. With an optional Y-cable
adapter, you also can connect any combination on two of these devices

simultaneously.

USB Port
The Universal Serial Bus (USB) port allows you to connect up to 127
USB-equipped peripheral devices (for example, printers, monitors,

scanners and so on) to your notebook computer.

LAN Port

If you purchase an internal 10Base-T/100Base-TX LAN module, it
connects your computet to othetr computers/networks through a local
area network (LAN).
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Modem Port
If you purchase an internal fax modem, a 56K internal fax/data modem is
installed. It keeps you connected to the outside world through networks.

Built-in Modem and LAN modules are available as option.

1394 Port
IEEE 1394 pott is a high speed I/O portt that can transfer high levels of

data in real-time, such as external hard disk, Digital Video Camera.

COM Port
Lets you connect a 9-pin external serial device such as a modem, mouse,

or other serial devices.

Print Port

Use this port to connect a parallel printer or other parallel device. The
parallel port supports Enhanced Capabilities Port (ECP) standard. The
standard provides you with a greater processing speed than the
conventional parallel port. The port also supports bi-directional and uni-

directional protocols.

The default setting for the parallel port on your notebook computer is set to
Enhanced Capabilities Port (ECP). Some older parallel devices may not
function with the ECP default setting. You may need to adjust the setting to

accommodate your parallel device by changing the BIOS setting.

Air Inhalant

Inhale the air into your computer to keep it within operating temperature.

CRT Port

Lets you attach an external CRT monitor for wider display. You can run
the LCD display and the external CRT monitor simultaneously or switch it
to CRT only using the display hot-key.
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e TV Port
Lets you connect to a RCA TV connector for presentation or VCD, DVD

watching.

The Left Side of the Notebook

The left side of your notebook computer provides the features shown in the

following figure.

06 6 o 8]

0. IR Port 0. Air-Outlet Vent

0. Microphone Jack 0. Stereo Line-In Jack

0. Headphone Jack 0. Thumb Wheel Volume Control
0. PC Catd Slots 0. Locking Device Keyhole

Left Side Features

e IR Port
Wireless data transfer of files between your notebook computer and an
IR-equipped device or notebook computer. You can also print to an IR-
equipped printer without using cables. The FIR mode provides up to
4Mbps of data transfer rate. The SIR mode provides up to 115.2Kbps of

data transfer rate.

e  Air-Outlet Vent

Emits the heat out of your computer and keeps it within operating
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temperature.

Do not block the fan while the notebook is in use.

Audio Ports

From left to right, the three audio jacks are Microphone, Line-In, and

Headphone which are described as follows:

0

Microphone Jack

Allows you to connect an external microphone for monophonic
recording through the unit. Plugging in an external microphone
disables the built-in microphone. Lets you connect an external
microphone to record monophonic sound directly into your

notebook computer.

Stereo Line-In Jack
Lets you connect an external audio device such as CD player, a tape

deck, or a synthesizer as an input source for recording purpose.

Headphone Jack
Lets you plug in a stereo headphone, powered speakers, or earphone

set with 1/8 inch phono plug for personal listening.

Thumb Wheel Volume Control

Allows you to control the speaker volume.

PCMCIA Slot

0

Lets you connect various PC cards such as Modem cards, Ethernet
LAN cards, and SCSI cards.

Double-deck PCMCIA slots that support two Type II PC cards at
the same time, or one Type III PC catd in the bottom slot.

Supports both 3V, 5V, and 12V 32-bit CardBus and 16-bit PC cards.
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e Locking Device Keyhole
Lets you attach a Kensington security system or a compatible lock to

secure your notebook computer.

The Right Side of the Notebook

The right side of the notebook computer offers the features shown in the

following figure.

0. Blue Tooth Switch 0. Blue Tooth LED

0. Diskette Drive 0. CD-ROM/DVD-ROM/CD-RW

Right Side Features

e  BlueTooth Switch
Slide the switch to enable or disable the Bluetooth function.

e  BlueTooth LED
The LED is light when you activate on the Bluetooth function.

e  Diskette Drive

A 3.5-inch floppy diskette drive comes installed in the notebook computer.

The drive accepts 1.44MB floppy diskettes.

¢ CD-ROM/DVD-ROM/CD-RW
Allows you to load and start programs from a compact disc (CD) or a
digital video disc (DVD) and play conventional audio CDs.
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1.8 The Underside of the Notebook

The bottom of the notebook computer offers the following features.

(3}
(4]
[5)
(6)
0. Tilt Foot 0. Modem/LAN Card Compartment
0. Tilt Foot 0. Memory Compartment
0. Battery Bay 0. Battery Release Latch

Bottom of the System

e Tilt Foot

Provides flexible keyboard angle.

e  Modem/LAN Card Compartment

Provides optional built-in Modem /T.AN card or Combo card inserted into this

compartment for executing relative functions.

e  Memory Compartment

Remove the screw to find two DIMM slots. One is inserted with SDRAM
memory board configured by the factory. The other is empty for upgrade

use.
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e  Battery Bay
Equipped with a choice of Lithium-Ion (Li-Ton) or Nickel Metal-Hydride
(NiMH) battery pack.

e  Battery Release Latch
Push the latch to the right end to remove the battery pack.

Notebook Accessories

AC Adapter

The AC Adapter supplies external power to your notebook computer and
charges the internal battery pack simultaneously. The AC adapter has an auto-
switching design that can connect to any 100VAC ~ 240VAC power outlets.
You just change the power cord if you are going to use your notebook in other

countries with different connector outlets.

When you connect the AC adapter, it charges the battery whether or not the

notebook computer is powered on.

Battery Pack

Aside from the AC adapter, your computer can also be powered through the
internal battery pack. The battery pack uses rechargeable Nickel Metal-Hydride
(NiMH) or Lithium-Ion (Li-Ion) battery cells that provide long computing
hours when fully charged and power management enabled. You should always
leave the battery inside your computer even when using the AC adapter as it
also acts as a back-up power supply in case power from the AC adapter is cut
off. It is also very important to have the battery pack always charged to prevent

battery cell degradation.
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1.10

Car Cigarette Power Cable

This accessory allows you to power your notebook computer in your car by
plugging into the cigarette socket and the other end to the DC-IN port. This

gadget, however, does not charge the notebook internal battery pack.

Notebook Options

DVD-ROM Device Pack

This device pack option plugs into the Device Bay and used for reading DVD
or playing DVD titles. DVD-ROM drives are also backward compatible with
CD-ROM, so you can also use any audio CDs, video CDs, photo CDs, and
CD-R.

CD-RW Device Pack

This device pack can write data to CD-R or CD-RW CD for you to backup the
data.

Audio DJ

This notebook comes with optional built-in Audio DJ panel. It can play your
Audio CD like the CD player without powering on the whole computer

Internal Ethernet LAN module

This notebook comes with an optional 10/100Base-T LAN module that
supports data transfer rates at 10Mbps and can be up to 100Mbps.

Internal Modem module

This notebook comes with a 56K internal fax/data modem module that keeps

you connected to the outside world through networks.
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Bluetooth Module

This notebook is ready for Bluetooth technology. This is a wireless connection
standard in a short-range radio technology. It aims at simplifying
communication between Net-enabled devices and the Internet. Bluetooth is in
essence a “personal-area network” technology for connecting computers to

peripherals and mobile phones.
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2

Getting Started

Your Notebook is designed and pre-configured for

easy setup and use. This chapter describes the
installation steps you should follow to get the
notebook up and running as quickly as possible.
Contact your dealer if they have pre-installed all the
needed drivers to fully operate your computer or if
there is an update on the driver installation of the

notebook.

2-1
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2.1

Using the Battery Pack

The notebook is designed to operate with one of the following power soutces:
e With AC power using the AC adapter connected to an electrical outlet.

e  With a Nickel Metal-Hydride (NiMH) or a Lithium-Ion (Li-Ion) battery
pack.

You should use the AC adapter whenever possible, relying on the battery pack

only when AC power is unavailable.

Before you use your notebook computer, install and recharge the battery pack
first. The rechargeable Li-Ion battery pack allows you to operate the notebook
without an external power source. When you connect the AC power adapter,
the battery immediately starts to recharge. Normal battery charging time is 2 ~
2.5 hours for Lithium-Ton (Li-Ion) battery pack when your computer is turned
off.

For maximum battery performance, fully discharge the battery first before
recharging it when you start to use it first time. To do so, unplug the AC
adapter, turn off power management features (through Setup and Windows),
and turn on the system. Once the battery is fully discharged, plug in the AC
adapter and recharge the battery.

If you do not discharge the battery completely, it fails to accept a full recharge.

[0 Li-Ion battery is vulnerable, do not charge it with other power adapter, or it

may cause fire or explosion.
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Installing the Battery Pack

This notebook provides the most convenient way to install the battery pack
into your computer. With the extended nose directed toward the compartment,

insert and push the battery pack.

Removing the Battery Pack

To remove the battery pack, slide the latch and take out the battery pack with

your finger.
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Replacing the Battery Pack

When your notebook estimates that the battery only has enough charge to
continue for a few minutes, it will alert you with a battery low warning beep. If
you are consuming a lot of power by using the audio system, the PCMCIA
slots, the hard, floppy disk drives, and CD-ROM drive (or DVD ROM drive),
your notebook might run out of charge much sooner than you expect. You
should always respond to the battery low indication by connecting to AC
power or turning off your notebook, or suspending your notebook to disk. If
you do not do so, the notebook will automatically suspend to disk and turn off.
The contents of the memory will store in the Suspend-to-Disk partition. You
will be unable to restart the notebook until you have connected to the AC
adapter or installed a charged battery. To replace the battery pack, refer to the
previous sections on “Installing the Battery Pack” and “Removing the Battery
Pack.”

L[ Ifyou do not have a “Suspend-to-Disk” partition or file prepared
beforehand and the battery is running low, the system will not be able to
enter suspend to disk mode, but would rather enter suspend to RAM mode.
The contents will be saved to the memory instead and you need to connect

the AC adapter.

24
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2.2

LI  Be sure to save your data before replacing the battety pack or connecting

the AC adapter. Failure to do so can result in data loss.

EXTENDING BATTERY LIFE

It is important to be aware of the simple things for extending the life of the
system main battery while you are on the road. You should find a working
place where the external lighting is not too bright and turn down the screen
brightness. Also, you can choose the available mode on the Power

Management item of the Control Panel in Windows.

Connecting the AC Power Source

The AC adapter provides external power source to your computer and charges
the internal battery pack at the same time. The AC adapter also has an auto-

switching design that can connect to any 100VAC ~ 240VAC power outlets.
To connect the power adapter:
1. Plug the AC power cord into the power socket of the AC power adapter.

2. Plug the other end of the AC power cord to a live AC wall outlet.

&l
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2.3

3. Plug the connector of the AC adapter to the DC-IN port found at the
back of the computer.

L[ Whenever possible, it is advisable to always have the AC adapter connected
to the notebook and the battery pack installed. This ensures continuous
power supply and prevents any data loss incurring from sudden power
breakdown.

L[J e For the power supply of this equipment, an approved power cord has to
be used.
® Make sure the socket and any extension cord(s) you use can support the
total current load of all the connected devices.
® Before cleaning the computer, make sure it is disconnected from any

external power supplies (i.e. AC adapter).

Starting Your Computer

The Power/Resume button is found on the top of the base unit. Press the
Power/Resume button to start your computer and check that if the Power
LED turns on.
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2.4

After a few seconds, the computer’s display will turn on and your computer
will begin to execute the Power On Self Test or POST to check if all system
components are running properly. Any error found during the test will be

displayed on the screen and may generate short beep sound as well.

After the test, the screen will also display a message “press <F2> to enter
SETUP”. You don’t need to run this program at the moment as your dealer
already made the necessary settings for your computer * optimal operation.

Refer to Chapter 6 on running the SETUP program later.

After the test has completed, your computer will start to search and boot up
the operating system from your hard drive. The notebook computer normally
comes with a Windows 98/Me/2000 operating system pre-installed in your
hard drive. Consult the Windows 98/Me/2000 manual on how to use the

program. If not, contact your dealer for assistance.

Adjusting the Display Controls

The LCD brightness adjustment is controlled by <Fn> +<F8> and <Fn> +
<F9> keys respectively. You need to press these hot-key controls after

powering on your notebook to suit your viewing pleasure.

The Brightness hot-key control adjusts the brightness on the LCD. The
brightness hot-key control will not set the LCD completely dark or bright; it
provides sufficient lighting to the LCD to match the external lighting of the
surrounding. The brighter the room, the more you need to increase the
brightness of the LCD.
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2.5

Installing the Notebook Device
Drivers

If you already have an operating system installed into your notebook computer,
it is best to install the needed device drivers for using the built-in devices of
your computer. Before installing the drivers, check with your dealer first if they
have already installed all the drivers along with the operating system. If not,

follow the procedures below:

RUNNING THE PHDISK SUSPEND UTILITY

The PHDISK utility of the notebook allows you to create a suspend-to-disk
(STD) partition or file that is used to save the opened files when you activate
STD mode and power off the computer. If you want to make use of the STD
feature, you need first to tun the PHDISK utility. There are two options for

executing this utility:

1. PHDISK/Create/Partition - you can choose to run Suspend-to-Disk
and save your work into an allocated fixed disk partition. This option
should be done before partitioning and formatting your hard disk. The
advantage of this option is that it is more secure since the files are saved in
a separate partition and has no risk of being deleted. The disadvantage of
this is that you need to allocate enough disk partition for future memory
upgrade. The STD partition should always be larger than the system
memory RAM.

2. PHDISK/Create/File - you can also choose to run Suspend-to-Disk and

save your work into a STD file. You do not need to allocate an extra disk
partition when running this option. The advantage of this is that you do
not need to allocate or waste extra disk partition. The disadvantage of this
option is that it is less secure since there is risk of deleting the STD file
although the file is hidden.
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RUNNING THE PHDISK/CREATE /PARTITION

Before you run this option, you should carefully consider how much disk size
you need to allocate for the STD partition. The STD partition should be larger
than the installed system memory RAM. If you are planning to install more
memory in the future, it is recommended to allocate more disk space. Run
FDISK under Safe mode command prompt only in windows system and
leave a disk space that is larger then the system memory RAM for Non-DOS
partition. This will later be used by the PHDISK for creating the STD
partition.

If you already run FDISK before, you need to delete the original partition of

the hard disk.

Load the notebook driver CD and look for the PHDISK program file. Run
“PHDISK/ Create /Partition” or “PHDISK/C/P”. The PHDISK utility
program will automatically assign a disk size in reference to the installed system
RAM to be allocated for the STD partition. After PHDISK has completed the
STD pattition, you will be prompted to reboot the system.

RUNNING THE PHDISK/CREATE/FILE

Creating a STD file is much simpler since you do not need to allocate an extra
disk partition. Load the notebook driver CD and look for the PHDISK
program file. Run “PHDISK/ Create/File” or “PHDISK/C /F”. PHDISK
will create the SAVE2DSK.BIN file on Drive C. The size of this file will
depend on the installed RAM memory of your computer. Make sute that there
is enough space in Driver C for you to create this file. This file also is hidden

and has read-only attributes. You must not delete this file.
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[0 During power on or restart, the system will detect if STD partition or file is
present. If not, it will show a red colored dialog box informing you that
“Save to Disk Partition Not Present” and “Save to Disk Feature Disabled”.
This warning message can be disable from "Advanced", ""Save to Disk

Warning" in BIOS setting by pressing F2 during system boot.

L[] Whenever you upgrade the memory, you need to delete the existing STD
partition or file and create a new one according to the new memory size.
Run PHDISK/Delete/Partition or PHDISK/Delete/File to delete existing
STD partition or file.

Installing Windows 2000 from CD-ROM or DVD ROM

To install Windows 2000/NT directly from your CD-ROM or DVD-ROM,
please go to Boot menu of BIOS setup menu. Use arrow key to select "ATAPI
CD-ROM Drive", then use "+" or "-" to move it to the top. Go to Exit menu
and select “Exit Saving Changes”. Accordingly, insert the Windows 2000
installation CD into CD-ROM drive with following the instructions on the

screen to finish the installation.

Installing Windows 98/Me from CD-ROM or DVD-ROM

The easiest way to install Windows 98/Me is to boot from Windows 98 start-
up disk. With Windows 98/Me start-up disk, you don't need to install CD-
ROM driver since the start-up disk can support virtually all CD-ROM device.
Insert Windows 98/Me Installation CD into CD-ROM drive and run

"setup.exe".

If you don't have Windows 98/Me start-up disk, you need to install CD-ROM
/DVD-ROM driver under DOS. Then, insert Windows 98/Me Installation
CD into CD-ROM drive and run "setup.exe"

2-10



Getting Started 2

INSTALLING THE VGA DEVICE DRIVER

Following is the procedure for installing the ATI Video Accelerator 3D

Adapter (English) VGA driver to your computer:

Installing VGA device driver for Windows 98/Me /2000

1.

Insert the CD containing the VGA driver for Windows into CD-ROM

drive.

Click the Start button and then click Run. In the Run dialog box, click

Browse button and specify the ditectory as
"E:\Drivers\win98\VGA\setup".

For Windows Me/2000, please change the "Win98" in the directory
"E:\Drivers\Win98\VGA\setup.exe" to Win2K or WinMe for fitting

the operating system you are using.

Select the language you want to appear in the Welcome message box.

Click Next for proceeding.

Select Yes to follow the "License Agreements". The Select Components

box appears.
Click Next to execute the installation.

Click Finish to complete the VGA driver Installation.

INSTALLING THE MODEM DEVICE DRIVER

Following is the procedure for installing the Lucent Data Fax Modem driver to

your computer:
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Installing Modem driver for Windows 98/Me /2000

1. Boot Windows from your hard disk and insert the disc containing the

Modem driver for Windows.

2. Click the Start button and then click Run. In the Run dialog box, click
Browse button and navigate to the directory as
"E:\Drivers\Win98\modem\setup.exe' where the modem driver is

located.

For Windows Me/2000, please change the "Win98" in the directory
"E:\Drivers\Win98\modem\setup.exe'" to Win2K or WinMe for

fitting the operating system you are using.

3. The system may prompt you the message to restart the computer to finish

the installation.

INSTALLING THE LAN DEVICE DRIVER

Following is the procedure for installing the LAN driver to your computer:

Installing LAN driver for Windows 2000
1. Click the Start button, then point to Settings, and click Control Panel.

2. Double-click on the System icon, Hardware and then click on the

Device Manager folder tab.

3. Under the Other Devices line, you will find the Ethernet Controller,
click Uninstall, OK, then Scan for hardware changes buttons to appear
the New Hardware Found Message Box.

4. In the Found New Hardware Wizard message box which shows searching

Ethernet Controller driver. Click Next to proceed to the next step.

5. Select "Search for a suitable driver for my device", and click Next.
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Tick on "Specify a location box"'. Then, click Next and Browse buttons
and navigate to the LAN driver location as "E:\Drivers\Win2K\LAN".
Click OK and Next to begin searching the driver.

The Add New Hardware will found Intel (R) PRO 100B PCI Adapter.

Click Yes to continue installing the driver.

Click Finish button to finish installing LAN driver.

Installing LAN driver for WinMe

1.

Boot WinMe from your hard disk and insert the disc containing the LAN
driver for WinMe. The New Hardware Found Message box appears.

You will find the message stated searching PCI Ethernet Controller

Device driver showed in the Add New Hardware Wizard message box.
Select "Specify the location of the driver", and click Next.

Tick on "Specify a location box"'. Then, click Browse button and
navigate to the LAN driver location as "E:\Drivers\WinMe\LAN"".
Click Next to begin searching the driver.

The Add New Hardware will found Intel PRO PCI Adapter... Click

Next to continue the driver installation.
Click Finish button to finish installing LAN driver.

Click Yes to restart the computer

Installing LAN driver for Windows 98

1.

2.

Boot Windows 98 from your hard disk and insert the disc containing the
LAN driver for Windows 98.

Click the Start button, then click Settings, and Control Panel. Double
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10.

11.

click System and click Device Manager tab. Under Other devices, you'll
see PCI Ethernet Controller. Select it and click Remove button.

Click Refresh button. The Add New Hardware Wizard will detect PCI
Ethernet Controller. Click Next to search for the driver.

Click Next to continue.

Tick Specify a location and click Browse button. Then, navigate to
"E:\Drivers\Win98\LAN" and click Next.

Click Next to accept the updated driver for Intel 82559 Fast Ethernet
LAN driver.

Click Next to continue with LLAN driver installation.

Insert the disk labeled "Windows 98 Second Edition CD-ROM", and
then click OK.

Type "E:\Win98", then click "OK".
Click Finish to complete installation.

Restart Computer to finish setting up LAN.

INSTALLING THE COMBO DEVICE DRIVER (LAN AND
MODEM)

Following is the procedure for installing the 3Com 10/100 Mini PCI Ethernet

LAN driver and PCI modem driver to your computer:

Installing LAN of Combo driver for Windows 2000

1.

2.

Click the Start button, then point to Settings, and click Control Panel.

Double-click on the System icon, Hardware and then click on the

Device Manager folder tab.
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Under the Other Devices line, you will find the Ethernet Controller,
click Uninstall, OK, then Scan for hardware changes buttons to appear

the New Hardware Found Message Box.

In the Found New Hardware Wizard message box which shows searching

Ethernet Controller driver. Click Next to proceed to the next step.
Select "Search for a suitable driver for my device', and click Next.

Tick on "Specify a location box"'. Then, click Next and Browse buttons

and navigate to the LAN driver location as
"E:\Drivers\Win2K\ Combo\LAN". Click OK and Next to begin

searching the driver.

The Add New Hardware will found 3Com 10/100 Mini PCI.... Click

Yes to continue installing the driver.

Click Finish button to finish installing LAN driver.

Installing LAN of Combo driver for WinMe

1.

Boot WinMe from your hard disk and insert the disc containing the LAN
driver for WinMe. The New Hardware Found Message box appears.

You will find the message stated searching PCI Ethernet Controller

Device driver showed in the Add New Hardware Wizard message box.
Select "Specify the location of the driver", and click Next.

Tick on "Specify a location box"'. Then, click Browse button and

navigate to the LAN driver location as
"E:\Drivers\WinMe\ Combo\LAN". Click Next to begin searching

the driver.

The Add New Hardware will found 3Com 10/100 Mini PCI... Click

Next to continue the driver installation.
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6.

7.

Click Finish button to finish installing LAN driver.

Click Yes to restart the computer

Installing LAN of Combo driver for Windows 98

1.

10.

11.

Boot Windows 98 from your hard disk and insert the disc containing the
LAN driver for Windows 98.

Click the Start button, then click Settings, and Control Panel. Double
click System and click Device Manager tab. Under Other devices, you'll
see PCI Ethernet Controller. Select it and click Remove button.

Click Refresh button. The Add New Hardware Wizard will detect PCI
Ethernet Controller. Click Next to search for the driver.

Click Next to continue.

Tick Specify a location and click Browse button. Then, navigate to
"E:\Drivers\Win98\ Combo\LAN" and click Next.

Click Next to accept the updated dtiver for 3Com 10/100 Mini PCI
Ethernet LAN driver.

Click Next to continue with LLAN driver installation.

Insert the disk labeled "Windows 98 Second Edition CD-ROM", and
then click OK.

Type " E:\Win98", then click "OK".
Click Finish to complete installation.

Restart Computer to finish setting up LAN.

Installing Modem of Combo driver for Windows 2000

1.

Click the Start button, then point to Settings, and click Control Panel.
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Double-click on the System icon, Hardware and then click on the

Device Manager folder tab.

Under the Other Devices line, you will find the PCI Simple
communication, click Uninstall, OK, then Scan for hardware changes

buttons to appeat the New Hardware Found Message Box.

In the Found New Hardware Wizard message box which shows searching
PCI Simple communication Controller driver. Click Next to proceed

to the next step.
Select "Search for a suitable driver for my device', and click Next.

Tick on "Specify a location box"'. Then, click Next and Browse buttons
and navigate to the modem driver location as
"E:\Drivers\ Win2K\ Combo\Modem". Click OK and Next to begin

searching the driver.

The Add New Hardware will found 3Com Mini PCI 56K Modem. Click

Yes to continue installing the driver.

Click Finish button to finish installing Modem driver.

Installing Modem of Combo driver for Windows Me

1.

Boot WinMe from your hard disk and insert the disc containing the
modem driver for WinMe. The New Hardware Found Message box

appears.

You will find the message stated searching PCI Communication

Device driver showed in the Add New Hardware Wizard message box.
Select "Specify the location of the driver", and click Next.

Tick on "Specify a location box"'. Then, click Browse button and

navigate to the modem driver location as
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"E:\Drivers\ WinMe\ Combo\Modem". Click Next to begin

searching the driver.

5. The Add New Hardware will found 3Com Mini PCI 56K Modem. Click

Next to continue the driver installation.
6. Click Finish button to finish installing modem driver.

7. Click Yes to restart the computer

Installing Modem of Combo driver for Windows 98

1. Boot Windows 98 from your hard disk and insert the disc containing the

modem driver for Windows 98.

2. Click the Start button, then click Settings, and Control Panel. Double
click System and click Device Manager tab. Under Other devices, you'll
see PCI Simple Communication Controller. Select it and click Remove

button.

3. Click Refresh button. The Add New Hardware Wizard will detect PCI

Communication Device. Click Next to search for the driver.
4. Click Next to continue.

5. Tick Specify a location and click Browse button. Then, navigate to
"E:\Drivers\Win98\ Combo\Modem" and click Next.

6. Click Next to accept the updated driver for 3Com Mini PCI 56K

Modem driver.
7. Click Next to continue with Modem driver installation.

8. Insert the disk labeled "Windows 98 Second Edition CD-ROM", and
then click OK.

9. Type "D:\Win98SE\Setup\Win98", then click "OK".
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10. Click Finish to complete installation.

INSTALLING THE AUDIO DEVICE DRIVER

Your notebook computer uses the ESS PCI Audio controller.

Installing Audio Driver for Windows 98/2000/Me

1.

Boot Windows from your hard disk and insert the disc containing the

Audio driver for respective Windows version.

Click the Start button, then click Run. In the Run dialog box, click the
Browse button and navigate to the ditectory as "E:\Drivers\
Win98\Audio" or "Win2k", "WinMe'"" path according to your
Operating System and run "EsSetup"'.

Click Next to proceed with the next step.

Select Upgrade Drivers or Install and click Next to begin installing the

audio driver.

Select "Yes, I want to restart my computer now" and click Finish to

complete the audio installation.

INSTALLING EASY SYSTEM DRIVER

Following is the procedure for installing the Internet and e-mail button keys.

Installing Easy System driver for Windows 2000

1.

2.

3.

Boot Windows from your hard disk and insert the disc containing the EZ

System driver.
Click the Start button, then point to Settings, and click Control Panel.

Click Add/Remove Hardware and follows the steps below, Next ->
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Add/Troubleshoot a device -> Next -> Add a new device -> Next -
> No, I want to Select the hardware from a list -> Next ->Other
devices -> Next ->Have Disk

Then, Browse the path to
"E:\Drivers\ Win2k\ EZsystem\ Genport.inf" and follows the

description of the system to finish and restart the computer.

After it is restarted, click the Start button, then click Run. In the Run
dialog box, click Browse button and navigate to the directory as
"E:\Drivers\Win2k\EZsystem\EzsystemA550V1.00.exe".

Run the command and finish the installation.

Installing Easy System driver for Windows 98/ WinMe

1.

Boot Windows from your hard disk and insert the disc containing the Easy

System button driver.

Click the Start button, then click Run. In the Run dialog box, click
Browse button and navigate to the directory as
"E:\Drivers\Win98\EZsystem\ EzsystemA550V1.00.exe",
"E:\Drivers\WinMe\EZsystem\EzsystemA550V1.00.exe"

Run the execution file for installing the EZsystem driver, and then click

Finish after complete the installing procedure.

Installing Snaptics - Touch Pad driver for Windows 98/Me /2000

1.

2.

Click the Start button, then point to Run to appear the Run dialog box.

Click the Browse button to specify the directory as
"E:\Drivers\Win98\Touch Pad\Setup.exe"
"E:\Drivers\WinMe\ Touch Pad\Setup.exe"
"E:\Drivers\Win2000\ Touch Pad\Setup.exe"
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2.6

3. Execute the setup program and then the Welcome dialog box appears.

4. Click Next continuously three times when the screen appears the Next

button.

5. Click OK to restart your system.

Turning off Your Computer

If you are not going to use the computer for awhile, it is best to turn off the
power of the computer for longer use. Before turning off the power, you need
to close first all application programs and shutdown the operating system.
Then, press the power button to switch off the power of your computer. If you
are using Windows 98 or its newer version, the system will power off by itself

whenever you shut down the operating system.

After turning off the computer, make it a habit to leave the LVDS panel open
for a while whenever used for an extended period of time. This allows the
inside parts of the computer to cool off. Closing the panel will force the heat
up against the LCD screen, which may degrade the LCD when done regulatly.
More importantly, never close the LVDS panel for a long period of time when

computer is on and power saving features are disabled.
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3 Using Your Notebook

@ ’~\. { Th1s chapter describes how to operate the standard built-

in features of the notebook that you normally would use in
your day-to-day computer work. If you are new to
computers and to your operating system, you also need to
read the manual for the operating system on how to work
with your computer. It is very important to familiarize
yourself well with the operating system. The succeeding
chapters not only guide you to go beyond the basics, but

also try other exciting features.
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3.1

3.2

Starting Your Operating System

The operating system is a must ingredient in using your computer. Without an
operating system, it is like playing chess without the chessboard. It is the
platform for all your software application programs to run on. The most
popular operating system today is Microsoft Windows. You should have
installed one operating system by your dealer unless you are an expert
computer user and would need a more powerful operating system. If you have
an operating system already installed in your computer, then you would be up
and running after you power on your computer and boot up the system. Check

your operating system manual on how to run it.

Knowing the Status of Your Computer

The Status LED Panel, located at the top of the base unit, provides you with
several graphical icons with LEDs (Light Emitting Diode) in representing your
system’s activity and status. You will glance it from time to time as you use

your computer.

O @ @ ©

0. Drive Access 0. Diskette Drive Access
0. Caps Lock 0. Scroll Lock
0. Num Lock Status LED Icons
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3.3

Drive Access
The drive folder icon indicates that the system is accessing the HDD or
CD-ROM/DVD-ROM/CD-RW.

Diskette Drive Access
The drive folder icon indicates that the system is accessing FDD. When
this LED lights, the notebook writes data to or retrieves data from the

floppy diskette drive.

Caps Lock
The Caps Lock icon indicates that the Caps Lock key on the keyboard is
activated. When activated, all alphabet keys typed in will be in uppercase

or capital letters.

Scroll Lock
The Scroll Lock icon indicates that the Scroll Lock key on the keyboard is
activated. The Scroll Lock key has different functions depending on the

software you are using.

Num Lock

The Num Lock icon indicates that the Num Lock key on the keyboard is
activated. When activated, the embedded numeric keypad LED will be
enabled.

Understanding the Keyboard
Functions

Your notebook computet is equipped with an 87/88 keys keyboard that
provides all the functionality of a full-sized 101 or 102-key IBM keyboard.
Aside from the standard typewriter-layout keyboard of your computer, there
are a number of extra features and function controls on the built-in keyboard

including Windows system hot keys.
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0. Function Keys 0. Control Keys

0. Windows Start Menu Key 0. Control Keys

0. Windows Shortcut Key 0. cursor Control Keys
Keyboard

Key features and operations are described below:

Function Keys

Function keys are application-driven, like F1 through F12 can be found on
the keyboard. These keys work together with the Fn key to activate special
functions. Some keys (printed in blue on keypad) are preprogrammed with

dual functions.

Control keys — Ctrl, Alt, Fn, and Shift are controls used in conjunction
with other keys to change their functions. To use control keys, press and
hold the control key while pressing another key. For example, “Press Ctrl-
C” means to hold down the Ctrl key and type the letter C. Key

combinations work especially to the application you are running,

Windows keys
Use the following two keys to facilitate your work:

34
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0  Start Menu key
Displays the Start menu.

0  Shortcut/Application key
Provides quick access to shortcut menus. This key acts like a right

mouse button.

Cursor Control keys

Cursor control keys let you position the cursor on the screen where you
want. In the screen, the cursor is a blinking undetline, block, or vertical bar
depending on the application. The cursor indicates where the next text

typed is inserted.

Typewriter keys
Typewriter keys (also called ajphanumeric keys) are used to enter text and
characters. Keys with blue print on them behave differently when

combined with control keys.
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BASIC KEYBOARD FUNCTIONS

Keypad

Function Description

< Enter

<Enter> key. Execute a command. Within many
text editing application programs, the <Enter>
key inserts a hard carriage return, just like what
ordinary typewriter does.

|
A

<Esc> key. Press this key to cancel or escape
from a command or function.

Prt Sc
SysRq

<PrtSc> key. Known as the Print Screen key.
Press this key to map the whole screen to shate
memory for your specific usage.

<SysRq> key. Used for multitasking operating
system.

Pause
B reak

<Pause Break> key. Press this key to temporarily
halt execution of a command. Pressing any other
key to resume execution of a command.

<Ins> key. Known as the Insert key. Press this
key to toggle the keyboard data entry from insert
to type over mode.

<Del> key. Known as the Delete key. Press this
key to delete the character to the right of the
cursor, or delete marked texts or items.

Backspace

<Backspace> key. Press this key to delete the
character to the left of the cursor.

> shift

WEEOEE

<Shift> key. Press this key in combination with
alphabet letters to produce uppercase letters in
typing. Use this key in combination with those
two-character keys (found on the second row of
the keyboard) to produce the upper marked keys.
Also used in most application program in
combination with other keys to execute a certain
command.
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Keypad Function Description
<Tab> key. Press this key to move the cursor to
b : the next tab stop on the right. This key works
much the same as in ordinary typewriter.
e ) <Ctr]> key. Known as the Control key. Used in

most application program in combination with
other keys to execute a certain command.

|

Alt

<Alt> key. Known as the Alternate key. Used in
most application program in combination with
other keys to execute a certain command.

ScrLocK

<Scroll Lock> key. Used in most application
program to scroll the screen without having to
move the cursor.

Num
L ocK

<Num Lock> key. Activates the embedded 15-

key numeric keypad. The keys are color coded
blue.

aps
L ock

LEE

<Caps Lock> key. Used in most application
program to always activate uppercase alphabet
characters.

CURSOR CONTROL KEYS
Keypad Function Description
Up arrow key. Moves the cursor up one line at a

f time.

il

) Down arrow key. Moves the cursor down one

‘ line at a time.

i
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Keypad Function Description
Left arrow key. Moves the cursor to the left one
T space at a time.
s
( ) Right arrow key. Moves the cursor to the right
" one space at a time.
e
SCREEN CONTROL KEYS
Keypad Function Description
<Home> key. Moves the cursor to the beginning
e of a screen or line.
i
( ) <PgUp> key. Moves the cursor up one screen at a
PgUp . ’
time
—
<PgDn> key. Moves the cursor down one screen
e at a time
<End> key. Moves the cursor to the end of a
2 screen or line.
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WINDOWS HOT KEYS
Keypad Function Description
<Start> key. Pulls up the Windows Start menu.
S
T <Right Click> key. Petforms a mouse right-click
% function for Windows system.

i

SPECIAL FUNCTION KEYS

The notebook has special system function keys that activate key serving dual
functions. When pressed in conjunction with the <Fn> key, these keys set

specific system parameters and ate sometimes referred to as “hot keys”.

Keypad Function Description

( Switches display between LCD, CRT, or
" + B8 LCD and CRT simultaneously.
Display
33 Switch the LCD display mode in expanded
Fn . .
+ or non-expanded view. These combination
keys only work in a 640x480 and 800x600

resolution mode.
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3.4

Keypad Function Description
( i Enable or Disables the built-in system
4 + [F6 speaker.
- Speaker
Increases the brightness of LCD display
F
" + 8 incrementally.

Axx

L

Decreases the brightness of LCD display

" n incrementally.
V3%

Using the Glide Pad Pointing Device

Your computer comes with a built-in Glide Pad pointing device that is found

on the center of the palm-rest surface.

The Glide Pad offers a number of options that let you customize how it
functions. To access these options, locate the Control Panel and double click
on the Mouse icon. The options let you control the size and color of the
cursor, cursor speed, the accepted double-click speed, and selection button

orientation.

The Glide Pad works a mouse pointing device replacement that is used under
Windows-based operating system. You can use the standard Microsoft or IBM
PS/2 driver that is compatible with the Glide Pad device and is normally used
under Windows-based operating system. However, if you want to utilize the
added features of the Glide Pad, you may want to try installing its own device

driver that comes with added utilities for enhancing the function of the device.
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0. Left Selection Button 0. Right Selection Button
© . Glide Pad O . Scroll Button
Glide Pad Features

Here how to use the Glide Pad pointing device:

1. The rectangular surface acts like a miniature duplicate of your display
screen. To move the mouse cursor, place the finger lightly on the sensor
pad and move in the desired direction. If you reach the end of the pad, lift
your finger and place it back down on the other side of the pad.

2. To select an item, click on the item by pressing the left button control or
by simply tapping on the surface once. A light, quick tap always works
best. To execute an item, click the left button twice or do a quick double

tap on the surface.
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3.5

3. To simulate holding the mouse button down (dragging an icon or
selection), use the tap-and-drag gesture. This feels much like a double-
click, except that the finger remains on the pad after the second tap: Tap,
lift, tap, hold and move. The simulated button remains held as long as the

finger remains on the pad.

4. To scroll up or down the screen, just slide up or down the scroll button to

move the screen up or down.

L[ Avoid spilling any Iiquid on the Glide pad surface and always keep the
Glide pad surface and pointing finger dry from sweat built-up. Also do not

expose Glide pad to any magnetic source object.

Configuring Your Screen Display

The VGA display function of your notebook is based on a high performance
AGP local bus controller and is fully IBM VGA compatible. This controller
offers a large set of extended functions and higher resolutions especially useful
when you are connecting an external high-resolution and high-frequency CRT
or LCD.

Please Refer to Section 5 ““ Installing the Notebook Device Drivers” of
Chapter 2 in this manual for the procedures on how to install the VGA device
driver under Windows. After installing the VGA driver, you would then
configure the display resolution or screen size to match your LCD display
panel. This notebook computer model provides 800x600 as well as 1024x768
LVDS panels. You would also probably want to set the amount of color output

to display sharper images and photos.
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POSSIBLE DISPLAY CONFIGURATIONS

The table below shows you the possible display resolution you can set when

using either the LCD display or the external monitor (CRT):

Display Possible Resolution Maximum Colors
800x600 640x480 16 million colors
SVGA L.CD 800x600 16 million colors
1024x768* 16 million colors
1024x768 640x480 16 million colors
XGA LCD 800x600 16 million colors
1024x768 16 million colors
CRT Only 640x480 16 million colors
800x600 16 million colors
1024x768 16 million colors
1280x1024 16 million colors
Both 640x480 65,536 colots
800x600 65,536 colots

1024x768* (SVGA LCD)
1024x768 (XGA LCD)

65,536 colors
65,536 colors

L[ *- denotes special panning feature that allows higher resolution modes to

be displayed on the LCD or CRT. This feature will show a section of a

larger screen, and will automatically pan or scroll the screen horizontally

and vertically when the mouse reaches the edge of the display.

L 65,536 or 64K colors is also equivalent to 16-bit high color while 16 million or

16M colors is equivalent to 32-bit true color.

L[ You can use the <Fn> + <F3> hot-key to switch the display between LCD
only, CRT only, or both LCD and CRT display.
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CHANGING THE DISPLAY PROPERTIES UNDER WINDOWS

To change the display properties of your screen under Windows system, just
right-click on the desktop area and select Properties or go to the Control Panel
and click on the Display icon. The Display Properties dialog box will appear on
your screen. Click on the Settings tab to set your desired configuration. Make

sure to follow the configuration table above.

L[ Ifyou cannot configure the display properties, change the display driver
first as mentioned on Section 5 “Installing the Notebook Device Drivers” of
Chapter 2 in this manual. Consult your dealer for the latest Windows-AGP
VGA driver.

Knowing the Power Saving Features

One of the great features in your notebook computer aside from its superior
performance is the ability to save energy power. Your computer is designed to
incorporate intelligent and advanced power management functions that turn
off power of most components when system is idle or not in use. This does
not affect the performance of your system as it monitors the activity of your
computer and resumes power and operating speed when activity is detected.
This feature not only gives you longer battery hours but cooler systems and
components as well. For more information on how to control the power
management features of your computer, refer to Power Management function

in Control Panel of Windows.

The definitions of power management mode are depicted as follows:
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Full-On Mode

No device in the system is executed in power management, the system can

respond to all applications at maximum performance.

Doze Mode

When no system activity executes, the CPU clock is slow down while all other

devices are in full-on state. This mode is controlled by the system itself.

Standby Mode

When the CPU clock stops, the LCD and HDD will also be turned off and all
other devices are in low power state. To resume full-on state, just press any

key.

Suspend to RAM mode

All devices are powered off except the other supporting components and
system memory where your working files are stored. You can activate this
either pressing the power button or setting the Suspend timer on the Power
Management function of the Control Panel in Windows. To resume full-on

state, press the power button.

Suspend to Disk mode

When this mode is activated, the context of the entire system is saved to disk
and all components and devices are powered off, while all clocks are also
stopped (except Real Time Clock or RT'C). You can activate this by setting the
Suspend mode on the Power Management function of the Control Panel in

Windows. To resume full-on state, you can press the power button.
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L[ You must have the PHDISK utility installed fitst before you can activate
Suspend-to-Disk.

Soft off mode

This mode is similar to Suspend to Disk mode, except the context of memory
is not saved to disk. The system only can resume from Soft Off mode by

executing the hard reset in the system.

Mechanical off Mode

All power, except the RTC (real time clock), has been turned off from the

system. This includes external AC power source and battery power source.

Using the FDD

Your system ships with a standard 3.5-inch 1.44-MB diskette drive already
installed in the right side of the system. The other disk drives on your
computer are the hard disk drive and the CD-ROM, CD-RW or DVD-ROM
drive. Disk drives are designated with drive letters, the floppy drive usually
assigned as Drive A: and the hard drive and CD-ROM, CD-RW or DVD-
ROM drive as Drive C: and Drive D: respectively. (Drive letter may change if

you had more than one partition in your hard disk)

The floppy disk drive (FDD) is a 3.5” diskette drive that can read and write to
high-density 1.44MB diskettes or double-density 720KB diskettes. The diskette
has an imprinted arrow on the front upper left corner, and a sliding write-
protect tab on the bottom left corner of the diskette. When opened, the write-
protect tab prevents any data from being written to or erased from the diskette.
This also protects your diskette from getting infected by virus when used on

other computers.
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Insert the diskette with the arrow and label facing up and the shutter cover
towards the drive. Slide the diskette into the drive until it is totally inserted and
the eject button pops out.

-

To eject or remove the diskette, make sure that the system is not accessing the
diskette drive. Check the Status LED Indicator panel if the Drive Folder icon
is activated or not. If not, then press the eject button on the drive to release the

diskette.

L[ Always remove the diskette whenever you are placing the notebook

computer into the carrying case for transport.

[0 Always check the inserted diskette for virus before using it.
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Working with the Built-in HDD

Your notebook computer is equipped with a built-in large capacity 2.5 inch
IDE hard disk drive where you store or install your computer * operating
system and all application software programs. The hard disk unit is located on
the center of your computer. You need to format the hard disk before using.
The internal hard disk is normally assigned as Drive C after formatting.
Sometimes divided into two partitions, adding a Drive D. Since your computer
supports different hard disk capacities (to 10 GB or above), you also need to
setup the disk type first on your computer’s BIOS SETUP program before
formatting the disk drive. Your computer supports Auto-detect hard disk type,
so you do not need to set it manually. Your dealer should already have done all
this for you. You can refer to Chapter 6 on how to run the BIOS SETUP

program.
You can increase the system’s storage capacity by replacing the standard hard

disk drive with a drive of greater storage capacity.

L[ Ifyou wish to replace your hard disk, contact your local dealer for more

information about this dealer-installable device.

[0 Always turn off your computer first before removing the hard disk drive.
Failure to do so will damage the computer and the hard disk. Avoid jarring

or moving the computer while the hard disk is still being accessed.

How to Access the CD-ROM/DVD-
ROM/CD-RW Drive

Your system ships with either a 24X or above CD-ROM, 4X or above CD-
RM, or 8X or above DVD-ROM drive installed on the right side of your
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computer. You would normally use the CD-ROM drive for installing operating

system and softwate application programs.

To insert and remove a disc on the drive:

1.

Make sure the computer is turned on. Press the eject button found on the
door cover of the CD-ROM drive. The CD tray mechanism will pop-out
slightly and slowly pull out the whole length of the tray.

Place the disc on top of the CD tray with the label side facing up. Gently

press the compact disc onto the center spindle to secure the disc.

To remove the disc, press on the center spindle and pull up the disc from

the side until the disc snaps out of the spindle lock.

If'the eject function is disabled by software or a power failure occurs, the
Emergency Eject Hole allows you to manually remove a CD from the

reader.

To close the CD-ROM drive, simply push the CD tray inside. The CD-
ROM LED will activate when the disc is detected. Wait until the LED has
turned off and then start to read the disc.

The above procedures also apply to CD-RW or DVD-ROW.

How to care the CD

When you handle CDs, pay attention to the following guidelines:
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e Always pick up the CD by its edges.

e  Avoid scratching or soiling the side of the CD that has no printing or
writing on it.

e Do not write on or apply labels to either side of the CD.

e Keep the CD away from direct sunlight or high temperatures.

e  C(lean fingerprints or dust from the CD by wiping it with a soft cloth.

The above points also apply to CD-RW or DVD-ROW.

[] The CD-ROM reader is a Class 1 Laser Product.

3.10 Using PCMCIA Cards

WHAT IS PCMCIA?

PCMCIA or Personal Computer Memory Card International Association is a
non-profit trade association that defines the industry standard for the PC Card
technology. The goal of PCMCIA is to ensure that any PC Card can work in
any mobile computer built with a PCMCIA slot.

A PC Card is a peripheral device that can add a wide variety of capabilities to
your computet including memory, mass-storage, LAN, fax/modem, wireless
communications, and multimedia. The PCMCIA standardized PC Card is
roughly the dimension of a credit card, and has a standardized 68-pin
connector at one end. The main benefits of the PC Card are its low-power

consumption, small size and ruggedness.

Today, PCMCIA card also uses in such diverse products as digital cameras, set-

top boxes, and automobiles.
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To allow manufacturers to add functions and technologies in the PC Card form
factor, PCMCIA has defined two PC Card types:

Type Thickness Sample Devices
Type 11 5.0 mm Fax/Modem & Network Cards
Type 111 10.5 mm Hard Disks (ATA Cards)

Type II Cards

Type II card has a thickness of 5.0 millimeters (mm). Type II cards are often
storage or communications devices such as battery backed Static Random
Access Memory (SRAM), Read Only Memory (ROM), Flash Memory, LAN,
and Small Computer System Interface (SCSI). Typical Type II cards include
input/output (I/O) features such as modems and LANSs. The features for Type

II Cards include following characters:

e  Type II Extended Cards
Many PC cards are Type II extended cards. The extended card has an
additional physical component that protrudes beyond the traditional card
size. The extension can be as large as 40 mm deep by 9.65 mm high. This
extension provides room for additional electronics as well as a location for

external connectors.

e  Communication Cards
Both network PC cards and fax/modem cards can use with your notebook
computer. However, if you use built-in LAN/Modem options of this
computer, it is not necessary to use those cards. If you start the
LAN/Modem application without insetting the fax/modem card ot had
the built-in LAN/Modem options installed, the application typically does
not find the card.
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e  Storage Cards
When you insert a storage card or small hard drive card in the notebook
computer, it appears as a unique drive depending on the type of card and

the slot you are using,.

The following table provides sample drive designations.

Sample Drive Designations

Drive letter Location/Device

Internal hard disk

Internal hard disk, 2nd partition
CD-ROM reader

Slot 1, IDE/ATA hard drive
Slot 0, high-speed memory card

NEER

Type III Cards

Type III cards are thicker (10.5 mm) than Type II cards and allow no
extensions. Type III card uses include advanced function I/O catds with added
features such as multimode cards (cards with more than one function) and

small hard drive cards.

Other Cards

Other kinds of PC cards ate available to notebook computer users.
e  Global Positioning System (GPS)
enable the tracking of remote units that equipped with the GPS device.
(For example, delivery trucks) This device is useful in searching city
map when driving,
e Paging

receiving paging messages and control the notebook remotely
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e Multimedia
combining animation and sound
e Video

recording, displaying, and capturing full-motion video

[ For more PCMCIA information on the Internet, visit the PCMCIA home
page at http://www.pc-card.com

WHAT IS CARDBUS?

CardBus is the high-performance 32-bit PCI bus master interface from
PCMCIA. It runs up to 33MHz clock speed and operates at only 3.3V. Your
notebook computer incorporates the CardBus inside with a double deck
PCMCIA slot that supports one Type III card or two Type II cards at the same
time. Aside from 3.3V CardBus PC cards, you can also insert existing 5V 16-bit

PC cards that can also be detected and used by your computer.

SETTING UP THE PCMCIA CONTROLLER

In order for your computer to identify inserted PC cards and configure them to
work, you need first to make sure that you have the Card and PCMCIA driver

software loaded propetly into your operating system.

INSERTING AND REMOVING A PCMCIA CARD

The double-deck PCMCIA slot built in at your computer supports either two
PCMCIA Type II cards at the same time or one Type II card and one Type 111
card at the same time. The double-deck PCMCIA slot compartment includes a
top slot and a bottom slot. Your computer also includes hot swapping
capability, that allows you to exchange cards while the computer is turn on and

start using it immediately.
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Inserting PC Cards
To insert a PC card into the PCMCIA slot:
1. Locate the PC card slot cover on the left side of the computer.

2. Insert the side of PC card with the 68-pin socket into the PC slot. The face
label of the card should also be facing up. You can insert either two Type
II or one Type I1I card into the slots.

3. When the full length of the card is almost inside the slot, push firmly but
slowly, to ensure full connection with the computer. The PC card will be
detected and once the needed driver is installed, it will generate a beep

sound to indicate that the card is detected.

Removing PC Cards

To remove a PC card from the PCMCIA slot, you should first disable the
PCMCIA card setting in the system as described followings:

1. Click the Start button, then point to Settings, and click Control Panel.

2. Double-click on PC Card icon to appear the PC Card Properties box.




Using Your Notebook 3

3. Select the socket from the list that you want to remove on the Socket
Status folder tab, and click Stop button. The system then disables the
function of PCMCIA card.

4. 'Then you can remove the inserted PC card, push the button found on the
left side of the PC slot to release the eject button. Then push it again to
release the PC card. The upper right button releases the card on the top

slot while the lower right button releases the card on the bottom slot.

5. When the PC card has moved out a space out of the slot, hold the edges
of the card and slowly slide it out.

MAKING PC CARDS WORK

Since PC cards come in different types and brands, making every card work on
your computer may not that be easy. PC cards like network, SCSI or
multifunction cards (MFC) need additional driver installation and configuration
in making the card work. This additional driver may already be built-in under
Windows that Windows will try to detect and prompts you if you want to
install the driver. If the driver is not included under Windows, you will need to
insert the driver CD or driver diskette provided by the PC card manufacturer
into the CD-ROM drive or floppy disk drive and install to Windows system.
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You need to read the manual guide of the PC card on how to configure and

operate the card.

o

Some PC cards require additional system resources. Before inserting a PC
card you may have to disable either the USB port, or the 56K internal
modem. Check the Windows device manager to ensure that one of these

devices is disabled before inserting a PC card.

HOT SWAPPING PC CARDS

Just like floppy disk drive, your PCMCIA slots allow you to replace one PC

card with another even while your computer is on. However, you need to

remember the rule that if the PC card is in use, you must not remove it. Below

are some examples on how to handle PC cards when in hot swapping:

Do not remove a network card while your system is connected to the

network.

Do not remove fax/modem card while the card is transferring data into or

from your computer.

Do not remove a hard disk or ATA card while your computer is accessing

the card.

PC cards draw power even when not in use. To save energy, press the button
to disconnect the card when it is not in use. You can leave the card in the

slot while it is disconnected for easy storage.
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4  Fun with Multimedia

This chapter lets you make full use of all the

multimedia features of your computer in having fun
and excitement during work or leisure. You will learn

how to mix and match the built-in sound system,

play CD via the Audio DJ without powering on the
computer, use CD-ROM, DVD-ROM, or CD-RW in

creating an exciting full multimedia presentation.
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4.1 Notebook Multimedia Features

Your notebook computer is rich in multimedia features that make your
computing fun, comfortable, exciting and easy. Exceeding the specification set
for the Multimedia Personal Computer or MPC, your computer is well able to

perform all multimedia tasks through the following:
e Intel Pentium III/Intel Celeron
e  (64MB RAM or more

e 24X or above speed CD-ROM Drive, 8X or above speed DVD-ROM
Drive, or 4X or above speed CD-RW

e AGP 2X VGA Graphics Controller

e 16-bit Plug-and-Play Audio Sound System with built-in speaker and

microphone

e Audio DJ panel that can play CD without powering on the computer

4.2 Audio Sound System Features

Your computer has a built-in 16-bit stereo sound controller that allows you to
record, store, and playback voice, music and other sound effects with built-in
mixer controls. An integrated full-duplex microphone and twin mini-speakers
are also built-in into your computer to allow you to record and playback sound

anytime and anywhere.

On the left side of your computer, you will find the audio ports that include the

following:
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4.3

4.1

e  External 1/8-inch microphone jack that connects external microphone for

recording purpose.

e  Line-in jack for connecting external audio devices like CD audio player,

tape deck or synthesizer
e Farphone or headphone jack for personal listening

e  External thumb-wheel volume control

Setting Up the Audio Driver
Properties

Before you can start using the audio capabilities of your computer, you need
first to setup propetly the audio driver after installing Windows. If you bought
your computer with Windows pre-installed, it is most likely that your dealer
have configured the sound driver for you. If not, you must refer to Chapter 2

on how to setup the sound drivers for Windows.

Windows Multimedia Programs

Windows provides several multimedia programs that you can run with the
built-in features of your computer. Pointing the Start button and clicking the
right-mouse button to select Open option, when Start Menu box appears,
double-click Programs, Accessories, then Entertainment, you will find the

Multimedia programs group.
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Figure 4-1 Multimedia Programs Group

The standard multimedia components are as follows:
e Windows Media Player - for playing sound, video and animation files
e Sound Recorder - for recording sounds and playback

e Volume Control - for adjusting the volume of mixer

[0 For more information on how to operate these multimedia components, run

the program and click on the Help menu.

4.5 Recording Sounds

Your computer allows you to record voice and other sounds in several ways
and stores them as files on your hard disk. These voice or sound files can then
be played back through the internal speaker or earphone jack using either an
external speaker, headphone, or earphone set. You can also use the files as

voice annotations on many applications for more real presentation. This
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section will describe briefly how you can record sounds under Windows

operating system.

To record sounds, you need to run the Sound Recorder program from the
Multimedia program groups. The control buttons of the Sound Recorder are
simple to understand which comprises of the Rewind, Forward, Play, Stop, and

Record button. Click the Help menu on how to operate the Sound Recorder.

4}- Sound - Sound Recorder M=l B3
File Edit Effects Help

Puosition: Length:

0.00 sec. 0.00 zec.
1

1]

| pp| » | =[]

Figure 4-2 Sound Recorder

The Sound Recorder also allows you to record sound from different input

audio source like the following:

e  TFrom the built-in microphone

e  From the external microphone

e From the CD-ROM/DVD-ROM/CD-RW drive
¢ Trom the Line-In audio jack

Since you could record sound from different input sources, you must first set
the proper audio input recording device under the Recording Control panel. To
do this:
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Double-click on the Volume Control on the taskbar or click Start button,
then point to Programs, Accessories, Entertainment and then click on

Volume Control.
Click Properties in the Options main menu.

Click the round button for Recording and tick off each component that

list in the "Shows the following Volume Controls" box.

Properties

Mizer device: [pog Allegro

— Adjust valurme For
™ Playback
* Fecording

" Other IDigitaI Audio Interface

Show the following volume controls;

Miver

CO Audio
Lire In
Mizrophione

Figure 4-3 Audio Properties

Click OK and the Recording Control dialog box will appear. Here, you
will select the input device for the recording source. The default is the
microphone that will record sound from the microphone only. If you want
to record from the CD-ROM/DVD-ROM/CD-RW drive with audio

music, you must click on CD Audio.
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USING THE BUILT-IN MICROPHONE

You would normally use the microphone for recording voice and save the file

for voice annotations in your application programs. Your computer comes with

a built-in microphone located on the left bottom corner of your keyboard.

To start recording from the built-in microphone:

1.

Enable microphone volume on the Recording Control as discussed

previously.
Run the Sound Recorder program and press the Record button.

Start to speak towards the built-in microphone and press the Stop button

when you want to stop recording.
Press the Play button to hear what you have recorded.

To save to file, click Save from the File menu.
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USING AN EXTERNAL MICROPHONE

Your computer also allows you to connect an external microphone for higher
quality recording. The external microphone jack is found on the left side of
your computer and automatically disables the built-in microphone when
connected. Use only microphone with 1/8-inch mini-jack connector. Follow

the same procedure for recording voice.

USING THE BUILT-IN CD-ROM/DVD-ROM/CD-RW
DRIVE

You would normally use the CD-ROM/DVD-ROM/CD-RW drive for

recording audio music from the compact disc. Follow these steps:
1. Activate CD Audio volume on the Recording Control as discussed eatlier.
2. Run the Sound Recorder program.

3. Insert the audio CD into the CD-ROM/DVD-ROM/CD-RW drive.
Unless you have disabled the CD auto-insertion notification for
supporting Suspend mode, the CD Player should automatically run after
you have inserted an audio compact disc and will start playing the audio
CD.

4. Click on the Windows media player (use WinMe as an example) as shown

in following figure, then press the CD Audio.
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Figure 4-5 CD Player

5. Select the starting point where you want to start recording.
6. Switch to the Sound Recorder and press the Record button.

7. Switch immediately to the Windows Media Player and press the Play
button. You can adjust the volume control so you can also hear the music

while in recording.

USING AN EXTERNAL AUDIO INPUT DEVICE

You can also record sound from an external audio device such as stereo

amplifier or tape recorder by connecting them to the Line-In audio jack

Use the same procedure as above by setting the Recording Control to enable
the line-in volume. Run the Sound Recorder and press the Record button. Start

playing the external audio device to begin recording.
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4.6 Playing Audio and Sound

Your computer has a built-in twin speakers to playback audio and sound. You
can also adjust the volume manually by adjusting the thumb-wheel volume

control found on the left side of your computer.

For more quality sound output, you can choose to connect an external
amplified speaker or earphone from headphone jack. Always minimize the

volume first before placing the phone set to your ear.

USING THE WINDOWS MEDIA PLAYER

The easiest way to playback multimedia media files is to run the Windows

Media Player. Follow these steps:
1. Click on Start, point to Programs, Accessories, and then Entertainment.

2. Click on Media Player to start program.

I:W'indows Media Player
File “iew Play Toolz Help

DO D e
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4.8

Figure 4-6 Media Player

3. Click on the File menu and select the file you want to play.

4. When the file is recognized and open, click on the Play button to start
playback.

Playing Video and MPEG Files

Your computer is capable of running video motion files as well as MPEG
(Motion Picture Expert Group) files on CD, DVD, or CD-RW. By using
software MPEG program, you can watch real full-motion picture on your
computer. You can also run the Windows Media Player under the

Entertainment programs group as well to show all media device programs.

Using DVD

DVD is the breakthrough in superb full-motion picture playback. One disc can
contain at least 4.7GB of information, capable of holding one full-length movie
with soundtracks, subtitles, and different languages. Much more, the DVD-
ROM drive of your computer is backward compatible with CD-ROM drive so
it allows you to use any CD as well. It also works the same as the CD-ROM.

To playback DVD titles, you would need a software MPEG-2 program and the
optional DVD-ROM Device Pack.

For software MPEG-2 program, the performance in media playing will be
implemented successfully only when this computer is complied with Intel

Pentium IT - 266MHz CPU or above. Otherwise, any computer that equipped

4-11



Notebook User Guide

4.9

under Intel Pentium II - 266MHz CPU cannot guarantee the performance in

media playing.

Using CD-RW

CD-RW drive is a device that can write digital data to CD-RW and CD-R
compact disk (CD). With this device, you can backup your own data to CD-R
or CD-RW disc for mass data storage and safely retaining. The CD-R disc can
be written several times until the CD-R is full; the CD-RW disc, furthermore,
can write and erase data repeatedly. Please refer to the related user manual
about the CD-RW software.

& Please pay attention to the copyright of the software or data you want to
backup. Backup or distribute the software or data might be illegal

according the restriction of the law.
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5 Connecting to Peripherals

- This chapter describes how you attach peripheral
devices to your notebook. You can attach a printer

or mouse; connect an external monitor and
‘ I | keyboard, or any other peripheral device. You will
learn how to use these peripheral devices with the

step-by-step instructions depicted in this chapter.

5-1



Notebook User Guide
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Using a Serial Mouse

Your computer has one 9-pin male serial port for connecting an external serial
mouse, modem or PDA. The serial (RS232) port of your computer is normally
referred to as COM1. When working with your computer on the desktop, you
may want to use an external serial mouse instead of the Glide Pad. If you want
to use a modem as well, we recommend using an optional built-in modem
module or a fax/modem PC card through the PCMCIA slot.

To install an external serial mouse:
1. Turn off your computer.

2. Plug the serial mouse connector to the serial port at the back of your

computer. Secure the connection with the screws provided.

3. Turn on the computer.

4. Click the Start button, then point to Settings, and click Control Panel

when there is another mouse connects to PS/2 port.

5. Double-click on the Add New Hardware icon to appear the Add New

Hardware Wizard.

6. TFollow the relative steps when screen shows up to guide you in executing

the specific procedures.
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7. When system has rebooted, Windows will automatically detect the serial

mouse.

Using an External Keyboard (PS/2)

At the back of your computet, you will find the 6-pin mini-DIN PS/2
keyboard and mouse port. This port allows you to connect an external full-
sized PS/2 desktop keyboard as well as an external PS/2 mouse. It is
recommended to use an external PS/2 mouse only if you ate not using an
external PS/2 keyboard. Otherwise, you must use the serial port for connecting
a serial mouse as discussed eatlier. If you want to use both the external PS/2

mouse and keyboard, you would need to buy a PS/2 Y-cable.

You can also purchase a keyboard adapter from your computer dealer that
allows you to connect standard 5-pin DIN-type desktop keyboards. To connect

the external keyboard:
1. Turn off your computer.

2. Connect the PS/2 keyboatd ditectly to the PS/2 pott. If you are using 5-
pin DIN-type keyboard, plug the keyboard to the keyboard adapter first
and then to the PS/2 port. Windows keyboatd are also supported.

3. Turn on your computer. Both the built-in keyboard and the external

keyboard are active and can be used simultaneously.
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5.3

[0 Do not disconnect or connect the external keyboard when power is on. Turn
off the computer first. You can connect an external keyboard or keypad only

while the system Is in Suspend mode.

To connect an external PS/2 mouse, follow the same procedutes as above. If
you set the PS/2 Mouse field to Both in Advanced menu of BIOS setting,
both the PS/2 mouse and the built-in Glide Pad will work at the same time

Using the USB Port

USB or Universal Serial Port is a peripheral bus standard developed by
Compaq, DEC, IBM, Intel, Microsoft, NEC and Northern Telecom. Personal
computers equipped with USB will allow computer peripherals to automatically
configure as soon as they are physically attached - without the need to reboot
or run setup. USB will also allow multiple devices to run simultaneously on a
computer, with peripherals such as digital cameras, scanners, printers, CD-
ROM drives, modems, keyboards, games devices and monitors acting as

additional plug-in sites, or hubs.
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[0 Depending on your operational requirements, you may need to disable

other ports in order to release system resource for the USB port.

Connecting a Parallel Printer

The parallel (LPT1) port has a 25-pin female connector at the back of your

computer. You would always connect to this whenever you are going to print

out to a parallel printer.

To connect to a printer:

1.

Connect the printer to the parallel port using the 25-pin male connector

cable of the printer. Secure the cable with the screws provided.

Align and connect the other end of the cable to the parallel port on the

device. Lock the connector clips.

Connect the power cable to the device and a properly grounded wall

outlet.

Power on both computer and printer.

Check the printer by doing a self-test operation.

Set the printer type of your software to recognize the connected printer.

If your printer is not listed in the software you are using, consult your

printer dealer for available drivers or any compatible ones.

Press the Online button of the printer.
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LI When you connect a printer, be sure to install the appropriate printer driver

through the Windows Control Panel.

L[] Check that the device is online before you try to use it. See the instructions

that came with the device for more information.

Using an External Monitor Port

Your computer has a 15-pin Monitor port for supporting any external CRT or
LCD color monitor with maximum display resolution of 1024x768 16M colors
or 32-bit true colors. You need a display signal cable (usually provided with the

monitor). One end of the cable must have a 15-pin connector for the system.

To connect an external monitor:

1. Turn off your computer and make sure the monitor power switch is
turned off.

L[ The notebook computer must be powered off or suspended while the
monitor is being connected.

2. Connect the connector cable of the monitor to the VGA port at the back

of your computer. Secure the cable connection with the screws provided.

3. Connect the monitor power cable and plug it into a propetly grounded

wall outlet.
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4. 'Turn the power of the monitor.

5. Turn on your computer. Both the LCD panel and the monitor screen will
show the display. Your computer is set at default to run at simultaneous

display mode.

6. If you only want to show the display on the external monitor (CRT/LCD)
and shut off the LCD display, you can use the <Fn> + <F3> hot-key to
switch display type between LCD and CRT. Keep pressing the hot-key
until you get the display to external CRT/LCD only.

L[ Refer to Chapter 3 regarding the possible External CRT resolutions and
how to change the display properties.

Using the IR Port (Option)

Your computer can equip with an industry standard IR port that allows
enhanced wireless connection with infrared built-in devices like PDAs,
electronic organizers, printers, and portable computers. The IR port is Infrared
Data Association (IrDA) compatible which makes use of the second COM
pott ot COM2 of your computer. The transfer rate for FIR is 4Mbit/sec.

To connect to another IR equipped device:
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1. Properly position both your computer and the target device. Place the
target device in line with your notebook and should be within 80cm (30-
inches) from each other. You should refer to the User + Guide of the

target device on how to enable its IR function.
2. Turn on your computer.

3. After setting up both devices to enable IR function, run the external

device's application that you wanted to connect to the IR port.

4. Set the transmission protocol or device to COM2 or specified by Windows
system. Make sure that this does not conflict with any pre-installed
fax/modem PC.

Using the TV Port

Also found at the back of your computer is one RCA port.
To display your computer screen on the TV:

1. Turn off your computer and plug one end of the RCA jack cable to the

end to the input video jack of your television set.

2. Turn on your computer and your television set.
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3. Click the Start button, then point to Settings, and click Control Panel.

mh | —
- QEEba NI

B

4. Double-click on the Display icon and point to Setting tab.

5. Double-click Advanced button and point to Displays tab.

6. Choose the TV button then click OK. Windows now automatically detect
the TV port and enable this function.

Using the IEEE 1394 Port

IEEE 1394 is a new I/O standard that is supported by Win98 (second edition)
or later Windows version. With supporting high-speed transmission and
delivering data at a guaranteed rate, you can record digital video clips and
download them directly via a super-speed IEEE 1394 port at the rear of the
notebook. IEEE 1394 becomes an ideal for devices that need to transfer high

levels of data in real-time.

With built-in IEEE 1394 port, this computer enables the peripheral devices in
transmitting digital video data or data backup. To install the IEEE 1394 port
driver, please refer to Win98 (second edition) or later Windows version. The
Windows system will automatically recognize it in installing a suitable driver for
it. For other version of Windows, please visit Microsoft's web site for more

information about it.
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Moreover, you should install the driver of peripheral device to connect with the
IEEE 1394 port, for details please refer to the manual that comes with your

peripheral device.

wh | '

5.9 Using the External Audio System

At the left side of your computer, you will find the built-in audio ports. You
can connect audio input jacks with stereo device; and headphone jack with

external speakers, earphone, or headphone for recording and playing sound.
To connect to a audio jack:

1. Locate the audio port (Microphone, Line-in or Headphone) that you want

to use to the target device.

2. Plug the jack into the port on the left side of the system.

L Ifyou use external speakers and experience the sound distortion or
feedback, please lower the volume. Some factors is caused by too close
locating the microphone and speakers from each other, moving away the

external audio option from the unit may also help.
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6 Customizing Your Notebook

Your computer uses the Phoenix BIOS Setup

program that allows you to set several system

configuration in changing the way your computer
performs. This includes your system time and date,
disk drive configuration and password setup. This
information is then stored in the CMOS RAM and
will remain permanent unless you change it again.
This chapter discusses on how you will activate the
BIOS Setup program and change the system
configuration to suit your desired operation. You
must be careful to set the configuration properly in
order for your computer to run smoothly. If you are

not sure of any settings, contact your dealet.
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Running the BIOS Setup Program

Your computer is likely to have been properly setup and configured by your
dealer prior to delivery. However, you may find it necessary to use the
computer’s BIOS (Basic Input-Output System) Setup program to change
system configuration information, such as the current date and time, or your
hard disk drive type. The Setup program can be accessed when you power on

the system and pressing the <F2> function key.

The settings that you specify within the Setup program are recorded in a special
area memory called the CMOS RAM. This memory is backed up by a battery
so that is will not be erased when you turn off or reset the system. Whenever
you turn on the computer, the system will read the settings stored in the
CMOS RAM and compare them to the equipment check conducted during the
Power On Self Test (POST). If an error occurs, an error message will be
displayed on the screen, and you will then be prompted to run the Setup
Program.

As the POST (Power-On Self Test) executes during the boot up process, the

screen will display the following message:
Press <F2> to Enter SETUP

Press the <F2> key to run the BIOS Setup program. The BIOS Setup program
is organized into five menus which you can select using the € and = keys. To
move from one option to another, you use the up and down arrow keys while
using the <F5> and <F6>, or <+>and <-> keys to change the settings. On
the right hand side of the screen are some brief help descriptions of each item

you want to change.

On the BIOS Setup program, you will find the following parts on the screen:
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e Item Specific Help
The right side of the screen. This atea describes each parameter and its

available settings.

e  Menu Bar
The top line of the screen. Each of the five selections displays its own

screen.

e  Parameters
The left side of the screen. This atea lists the parameters and their current

settings.

e  Key Status Bar
The bottom part of the screen. These lines display the keys available to

move the cursor, select a particular function and so forth.

To exit the BIOS Setup program, simply press the <Esc> key and select from
the Exit menu whether you want to Save changes and exit; Discard Changes

and exit.
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6.2 Using the Main Menu Setup

| PhoenixBIOS Setup Utilit
Main Advanced Security Boot Exit

Item Specific Help
System Time: jA:00 :00] <Tab>, <Shift-Tab>,
System Date: [08/10/2000] or <Enter> selects
field.
Diskette A: [1.44MB, 3'5”]
» Internal HDD [20004MB]
Internal CD/DVD [CD/DVD]
Boot Display Device: [Both]
System Memory: 640 KB
Extended Memory: 262143 KB
CPU Type: Pentium ® IIT
CPU Speed: 850 MHz
BIOS Version: 0.2B-0220-0713
F1 Help AV Select Item F5/F6 Change Values F9  Setup Defaults
Esc Exit €-> Select Menu  Enter Select » Sub-Menu F10 Save and Exit
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System Time

Allows you to change the system time using the hour:minute:second
format of the computer.

Enter the current time for reach field and use the <Tab>,
<Shift>+<Tab>, or <Enter> key to move from one field or back to
another.

You can also change the system time from your operating system.

System Date

Allows you to set the system date using the month/date/yeat format.
Enter the current time for reach field and use the <Tab>,
<Shift>+<Tab>, or <Enter> key to move from one field or back to
another.

You can also change the system time from your operating system.

Diskette A
This item enables or disables the floppy disk drive by pressing the
<Enter> key.

Internal HDD
This field displays various parameters for the hard disk drive. If type [Auto]
is selected, the system automatically sets these parameters. If type [User] is

selected, Cylinders, Heads and Sectors can be edited.

Internal CD/DVD
This field is for information only as the BIOS automatically detects the
CD-ROM.

Boot Display Device

Lets you select the display device.

System Memory
This field reports the amount of base (or conventional) memory found by
the BIOS during Power-On Self-Test (POST).
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Extended Memory
This field reports the amount of extended memory found by the BIOS
during Power-On Self-Test (POST).

CPU Type
This field reports the CPU type information detected by the BIOS during
Power-On Self-Test (POST).

CPU Speed
This field reports the CPU speed information detected by the BIOS
during Power-On Self-Test (POST).

BIOS Version
This field is for information only as the BIOS displays the BIOS version
during the Power-On Self-Test (POST).
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6.2.1 INTERNAL HDD SUB-MENU

PhoenixBIOS Setup Utilit
Main Advanced Security Boot Exit

Internal HDD: [12073MB] Item Specific Help
Type: User = you enter
Cylinders: [16383] parameters of hard-
Heads: [16] disk drive installed
Sectors: [63] at the Connection.
Maximum Capacity: 20004MB Auto = autotypes
Hard-disk drive
Multi-Sector Transfers: [16 Sectors] installed here.
LBA Mode Control: [Enabled] None = no device is
32 Bit I/O: [Disabled] installed here.
Transfer Mode: [Fast P1O 4] CD-ROM =a CD-
SMART Monitoring: Enabled ROM drive is
Ultra DMA Mode: [Mode 2] installed here.
F1 Help MV Select Item F5/F6 Change Values F9 Setup Defaults
Esc Exit &> Select Menu  Enter Select » Sub-Menu F10 Save and Exit

Use the Type field to select the drive type installed. You can select different
drive types as CD-ROM, User, Auto or None by pressing <Space> bar. Set
this option to Auto so your computer will automatically detect the drive type
during power on. Set this option to None when your computer is not installed

any devices. Press <Esc> to return to the Main Menu.
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6.3 Using the Advanced CMOS Setup

——

PhoenixBIOS Setup Utilit

Advanced Bo
Item Specific Help
NumLock on Boot: [Auto] ‘Disabled’ prevents any
PS/2 Mouse: [Auto] installed PS/2 mouse
LCD Panel View Expansion: [Enabled] from functioning, but
Suspend Warning Tone: [Enabled] frees up IRQ12.
‘Enabled’ allows the
Save to Disk Warning [Disabled] operating system to
Summary Screen [Disabled] determine whether
to enable or disable
Silent Boot: [Enabled]
Intel(R)SpeedStep(TM)technology [Automatic]
» 1/O Device Configuration
F1 Help MV Select Item F5/F Change Values F9 Setup Defaults
6
Esc Exit &> Select Menu Enter Select » Sub-Menu F10 Save and Exit

NumILock on Boot

Locks or unlocks the Num-Lock key during the system booting up

procedure.

PS/2 Mouse

[Auto] allows the OS to enable the PS/2 mouse when it is detected.

[Disabled] prevents any installed PS/2 mouse from functioning. [Both]

activates both the touch pad and external PS/2 mouse
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LCD Panel View Expansion

Expands or keeps the original LCD Screen View during the booting
procedure. Expands may get full screen LCD display, however, it degrades
the graphic/text quality.

Suspend Warning Tone
Enabled or disabled the Suspend warning tone when the system goes into

the Suspend mode.

Save to Disk Warning
Displays warning message when the Save to Disk file (save2dsk.bin) does
not exist. The file "save2dsk.bin" is used to save the data when your

computer goes into suspend to disk mode.

Summary Screen

Displays system configuration on boot.

Silent Boot
Lets you specify your boot screen to Logo screen, POST screen, or Black

screen by choosing Enabled, Disabled, or Black option, respectively.

Intel ® SpeedStep™ Technology

Automatically increase or decrease the CPU frequency to high or low
speed by selecting appropriate mode to Automatic, Battery Optimized, or
Disabled. For example, if the high speed and low speed of CPU are
900MHz and 750MHz, then you will get the following result via setting to
different options:

0  For Automatic, system will automatically detect whether the AC
adapter is connected or not, if it is connected, system will set CPU
speed to 900MHz (high speed), otherwise it will set to 750MHz (low
speed).

0  For Maximum, system will always set CPU speed to 900MHz (high
speed).
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0  For Conserved, system will always set CPU speed to 750MHz (low
speed).
e 1/0O Device Configuration

Lets you configure input/output device such as Serial Port, Parallel Port,
and Floppy disk controller.




Customizing Your Notebook 6

6.3.1 PERIPHERAL SUB-MENU

| PhoenixBIOS Setup Utilit
Advanced Security

Boot Exit
I/O Device Configuration ‘ Item Specific Help
Serial port A: m Configure serial port A
Parallel port: [Auto] [Disabled]
Mode: [Bi-directional] No configuration,
Floppy disk controller: [Enable] [Enabled]

User configuration,
[Auto]
BIOS or OS chooses

configuration,

F1 Help MV Selectltem F5/F6 Change Values F9  Setup Defaults
Esc Exit € Select Menu Enter Select » Sub-Menu F10 Save and Exit

e  Serial port A
You can select the Enabled, Disabled, or Auto option for enabled or
disabled the port, or automatically sensed the address assignment by BIOS
or OS.

e  Parallel port
Allows you to select the Enabled, Disabled, or Auto option for enabled or
disabled this port, or automatically sensed the address assignment by BIOS
or OS.

e Mode
Allows you to select a parallel mode as Output only, Bi-directional, EPP or
ECP when the parallel port is configured. When you set the configured
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parallel port to Enabled, you need to set the parameter of Base I/O
address for this port.

e  Tloppy disk controller
Allows you to select the Enabled or Disabled option for configured or not

configured the floppy disk controller.

6.4 Security Menu Setup

| PhoenixBIOS Setup Utility |
Security

Item Specific Help

Set Supervisor Password: Supervisor Password

Set User Password: [Enter] controls access to the

setup utility.

Password on boot: [Disabled]
Fixed disk boot sector: [Normal]
Diskette access: [Supervisor]

F1 Help NV Select Item F5/F6 Change Values F9 Setup Defaults

Esc Exit € Select Menu Enter Select » Sub-Menu F10 Save and Exit

e  Set Supervisor Password
Supervisor password gives you the authority in accessing the setup utility.
You also need to enter this password in system booting and resuming
from suspend mode. When you press <Enter> in this field, the Set
Supervisor Password dialog box appears. Enter a new password with up

to 8 alpha-numeric characters, and then re-enter it for confirmation.
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Set User Password

This field is only available when Supervisor Password has set. Enter the
user password when boot the system or resume from suspend mode. But
if the Write Protect is set in the Fixed disk boot sector field, you should
enter a supervisor password to access the fixed disk when boot the system

or resume from suspend mode.

Password on Boot
If you set this field to Enabled, your computer will always ask for the

password every time you boot your computet.

Fixed Disk Boot Sector
If you set this field to Write Protect, the write protect boot sector on hard
disk will protect against viruses. In this situation, only the supervisor can

access the Boot Sector of fixed disk.

Diskette Access
If you set this field to Supervisor, only the supervisor can access to the
diskette drives. If you set to User, both the supervisor and user can access

to the diskette drives.
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6.5 Using the Boot Setup

This item allows you to set the search drive sequence where the system will try

to boot up first.

PhoenixBIOS Setup Utility

Boot
Item Specific Help
ATAPI CD-ROM Drive Use <> or <i> to
+Diskette Drive select a device, then
+Hard Drive press <+> to move it

up to the list, or <->to
move it down to the
list. Press <ESC> to

exit from this menu.

F1 Help MV SelectItem F5/F6 Change Values F9 Setup Defaults
Esc Exit € Select Menu Enter Select » Sub-Menu F10 Save and Exit

To select the boot device, you can use the up or down arrow key, then press
<+> to move up the device in the list or press <-> to move down the device

in the list. To exit from this menu, press <Esc>.
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6.6 How to Exit the Setup Program

There are two choices to escape from the Setup program.

PhoenixBIOS Setup Utilit

Main Advanced Security Boot Exit

Item Specific Help

Exit Saving Changes Exit System Setup
Exit Discarding Changes and save your
Load Setup Defaults changes to CMOS.

Discard Changes
Save Changes

Battery Refresh

F1 Help MV Select Item F5/F6 Change Values F9  Setup Defaults
Esc Exit €= Select Menu Enter Execute Command F10 Save and Exit

e  Exit Saving Changes
Saves all changes to CMOS while running the BIOS setup program and

exit from the system setup program.

e  Exit Discarding Changes
Allows you to discard all changes made while running the BIOS setup

program and exit from the system setup program.

e Load Setup Defaults
Lets you load the default values for all setup items.
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e  Discard Changes

Reverts to previously selected settings.

e  Save Changes
Saves Setup data to CMOS.

e  Battery Refresh
Conditions the battery so that the battery can be fully charged. The
function applies to NiMH battery only.

6.7 How to Upgrade the BIOS

Your computer uses EPROM Flash BIOS chip that allows you to easily
upgrade the BIOS program. When you update the BIOS, any customized

settings you made are lost.

To upgrade the BIOS:

1. Insert the BIOS Update diskette into the diskette drive.

2. Power on the system with the diskette in the diskette drive.

3. On the DOS prompt, type the following command.

A:\>Phlash XXXXXX.ROM (BIOS filename)

4. Press <Enter> to run this BIOS utility. After the system has been

successfully run this program, a message similar to the following appears:

Flash memory has been successfully programmed,
press any key to restart the system. If the
system does not restart, turn it off, then turn

on again.

5. Press any key to restart this system.
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Contact your dealer for the latest BIOS update file.
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7 Using Options

°« [ This chapter describes the most advanced features

and expandable architecture in your notebook. With
the built-in optional internal modem and LAN
modules, you can easily execute each function only
by connecting the cable to the modem or LAN port.
You can also upgrade your memory size to your

system for specific requirements.
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7.1

LAN Module Option

This notebook comes with a built-in optional internal 10Base-T/100Base-TX
LAN module that connects your computet to other computers/networks
through a local area network (LAN) and supports data transfer rates at 10Mbps
and can be up to 100Mbps. The 10Base-T standard also called T'wisted Pair
Ethernet is connected with RJ-45 connectors. The 100Base-TX is based on the
older Ethernet standard. Because it is 10 times faster than Ethernet, it is often

referred to as Fast Ethernet.

CONNECTING THE INTERNAL LAN MODULE

The built-in LAN module provides a standard RJ-45 connector. We provide

you a twisted-pair cable for your convenience.
To connect the twisted-pair cable to your LAN port:

1. Locate the twisted-pair cable in the accessories box in notebook shipping

carton. Each end of the cable has a RJ-45 connector.
2. Connect one end of the cable into the network wall outlet or HUB.

3. Connect the other end of the cable into the computer RJ-45 LAN port.

wh ——
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7.2

Modem Module Option

This notebook comes equipped with a 56K internal fax/data modem that
allows you to communicate with others via fax, email, or to connect to an

online service or bulletin board. The modem module is available as an option.

CONNECTING THE INTERNAL MODEM

The built-in fax/data modem provides on standard phone connector. We

provide you one analog cable for your convenience.
To connect the analog phone cable to your modem:
g P y

1. Locate the analog phone cable in the accessories box in notebook shipping

carton. Each end of the cable has a RJ-11 connector.
2.  Connect one end of the cable into a standard wall outlet.

3. Connect the other end of the cable into the computer modem port.

L[ The speed of data transmission is dependent on the quality of telephone
Iines. Digitally terminated lines improve the speed of data transmission.

Contact your service provider for more information.
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7.3

L[] The analog phone cable is an industry standard cable. Longer cables are

available at your local electronics store.

L[ Ifyou want to buy the telephone line by yourselves, please be sure that only

No. 26 analog phone cable can connect to your computer.

System Upgrade

This section provides an easy step in doing system upgrade for your notebook

computer. The upgrade procedures include the following:

MEMORY UPGRADE PROCEDURES

Your notebook computer offers two 64-bit memory slots using 144-pin
SODIMM (Small Outline Dual Inline Memory Module) at least 64MB and
128MB SDRAM. The memory compartment is located just under your

computet.
Based Memory Installing Memory Total
64 MB 0MB 64 MB
64 MB 64 MB 128 MB
64 MB 128 MB 192 MB
128 MB 0MB 128 MB
128 MB 64 MB 192 MB
128 MB 128 MB 256 MB
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INSTALLING MEMORY MODULE

Your computer comes with standard 64 or 128MB of synchronous DRAM
(SDRAM). You can increase system memory to a maximum of 256 MB in the
system, by installing one small outline double inline memory modules (SO-

DIMMs) with installed base memory in the system.
The 64MB memory module and 128MB memory module are available:
To install the memory module:

1. Make sure the system is powered off, the battery also is removed and that

no peripheral devices are attached.

2. Turn the computer upside-down and locate the screw that secures the
DIMM door at the underside of the notebook.

3. Remove the screw and open the DIMM cover by your finger.

4. Locate the memory module into the empty memory module sockets.
(Your system comes with one memory module already installed in the

socket.)
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L[] Avoid touching the exposed components inside the system. Doing so may

damage the system.

5. Insert the connector of the memory module into the socket. Make sure the
notch of the memory module fits the nose of the socket.
* Hold the memory module at a 30-degree angle and push its
connector into the memory socket of the notebook.
* Press down on the edge of the memory module until the locking
tabs on both sides is locked.

6. Put the DIMM door back and secure the screw on the DIMM doot.
7. Turn the system over.

To remove a memory module, push the locking tabs aside from the memory

module until the module pops up. Then, remove the memory module.
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8

Caring for Your
Notebook

~

Your Notebook PC is a fully IBM compatible

portable personal computer with the latest features in

mobile computing and multimedia technology.

/}y Lightweight and compact, your Notebook PC runs on
a whole wide range of general business, personal

productivity, and professional applications, it is ideal

for use in the office, at home, and on the road.

Your Notebook PC also allows you for several levels
of customization and expansion that are previously

available only on desktop PCs.
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8.1

Important Safety Instructions

Portable computers take the most beating from end users. This section gives

you detailed information about how to maintain a safe working environment

while using the notebook computer. You can maintain its condition and

performance by following these guidelines. Please read it carefully to ensure

maximum safety.

Before cleaning the notebook computer, make sure it is disconnected from

any external power supplies (i.e. AC adapter, car adapter and so on).

When cleaning, do not use liquid or sprayed detergent for cleaning.

Instead, use moisture sheet or a cloth for cleaning,.

The socket-outlet shall be installed near the notebook computer and shall

be easily accessible.
Please keep the notebook computer from humidity.

Lay the notebook computer on a reliable surface when installing. A drop

or fall may cause injury.

The openings on the enclosure are for air convection hence the notebook
computer can be protected from overheating. DO NOT COVER THE
OPENINGS.

Be careful of using power supply. The notebook computer has specific

power requirements.
Use only a power adapter approved for use with this notebook computer.

The power adapter may have a 2-prong plug. This is an important safety
feature. A compatible outlet is required. If it is not available, find a

qualified electrician to install one.
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While unplugging the power cord, disconnect it by the plug head, not by

its wire.

Make sure the socket and any extension cords you may use can support

the total current load of all the connected devices.

Though your AC adapter is suitable for universal international voltage, it
still requires a stable and continual power supply. Make sure the voltage of
the power source when connect the notebook computer to the power
outlet. If you are unsure of your local power specifications, consult your

dealer or local power company.

Place the power cord in such a way that people cannot step on it. Do not

place anything over the power cord.
All cautions and warnings on the notebook computer should be noted.

If the notebook computer is not in use for a long time, disconnect it from

mains to avoid possible damage by transient over-voltage.

Never pour any liquid into openings as this may cause fire or electrical
shock.

Never open the notebook computer. For safety reason, the notebook

computer should only be opened by qualified service personnel.

If one of the following situations atises, have the notebook computer

checked by service personnel:

0 The power cord or plug is damaged.

0 Liquid has penetrated into the notebook computer.

0 The notebook computer has been exposed to moisture.

0 The notebook computer has not worked well or you cannot get it

work according to user’s manual.
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3.2

O The notebook computer has dropped and damaged.
O The notebook computer has obvious sign of breakage.

¢ Do not leave this notebook computer in an environment unconditioned.
Storage temperature above 60°C (140°F) may damage the notebook

computer.

e Anapproved power cord has to be used for the notebook computer’s
power supply. For a rated current up to 6A and equipment weight more
than 3 kg, a power cord not lighter than HO5VV-F, 2G, 0.75mm?, has to
be used.

e To avoid any damage happened to the internal device, you should first
disconnect the AC adapter and remove the battery pack from the

notebook when replacing any internal device.

The sound pressure level at the operators' position according to IEC 60704-1 is
equal ot less than 70dB(A).

Cleaning Your Computer

When it is necessary to clean the plastic case and keyboard, use a soft, lint-free
cloth, slightly dampened with a mild detergent solution or use the contents of

any commercially available computer cleaning kit.

Never use alcohol, petroleum-based solvents, or harsh detergents to clean the
notebook. Also never spray any liquids directly on the computer case,
keyboard, or screen. If the liquid-crystal display (LCD) screen has become
smeared or dusty, clean the screen by first applying a mild glass cleaner to a
soft, clean, lint-free cloth, and gently wipe the glass. Never apply liquids directly
on the screen surface. Moreover, do not use paper towels to clean the display

screen. Paper can scratch the display screen matte.
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8.3

8.4

Maintaining the LCD Quality

When it comes to screen problems, heat plays a big part. After a good working
session, the typical routine is to shut the machine and close the cover. But the
display surface - no matter what type it is - and the components inside the
computer radiates heat; when you close the cover, you trap the heat against the
screen. Leave the computer's cover open for about ten minutes while the heat
disperses. Make this a habit.

You should also enable the power management of your computer to turn off
the LCD power and display when the system is in inactivity for some time.

Adding screen savers is also acceptable.

Follow the safety guidelines mentioned eatlier and how to clean your

computer .

Maintaining Your Hard Disk

Losing your data has the same consequences as a system break down. Users
must make it a habit of doing hard disk maintenance every week or so. Here is

some maintenance you could do:
e Always back up your data files from your hard disk.

e Install a virus-detecting program to monitor virus that could tamper your
files.

e Use SCANDISK once in a while to correct any errors found in the
directory and File Allocation Table (FAT). This will also free up space

from any unused sectors.

e Never move or raise the computer while the hard disk is being accessed,

most especially don't jar the hard disk as this may cause a hard disk crash.
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3.5

Use hard disk maintenance programs like DEFRAG or Norton Ultilities
SPEEDISK. These reorganize your hard disk by eliminating fragmentation

and improving your hard disk access time.

Install a system password in your computer so others won't be able to use
the hard disk.

Battery Care Guidelines

The battery pack furnished with the computer requires reasonable care and

handling to ensure efficient operation and maximum life. There is a risk of fire

and chemical burn if the battery pack is handled improperly.

To ensure that the battery pack endures normal life cycle, always observe the

following precautions when handling the battery pack:

Handle batteries carefully. Do not try to disassemble, crush, puncture,
open, drop, mutilate, short external contacts, disposed of in water or fire,

or expose it to temperatures higher than 60 C.

Recharge batteries only as described in this manual and only in ventilated
areas. Never use an external charger other than the one supplied with your

computet.
Do not leave batteries in hot locations for more than a day or two.

Do not leave your battery in your computer for longer than a week

without plugging in the power adapter.
Do not leave battery in storage for more than 6 months without
recharging it.

Dispose dead battery properly to protect the environment. The batteries
contain hazardous chemicals and should not be thrown out with

household or office trash.
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3.6

Discharge completely the battery before recharging to improve battery

performance.

When You Travel

For safety and convenience when traveling, please follow these instructions:

Back up all needed files on your hard disk before traveling.

Recharge your battery overnight to ensure full battery power before you

leave.
Don't forget to bring along the AC adapter and extra battery pack.
Try to bring backup software as well.

Check the voltage rating and the outlet type of your destination. If the
power cord of the adapter is different, then you need to purchase a

suitable one. Consult your dealer.

Carry your computer in its carrying case or in a briefcase. Never check-in

the computer as a luggage.

Remember to apply those power saving features and techniques to save

battery power.
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APPENDIX A

Hardware System Information

=
<

This appendix gives information on the technical

and hardware specifications of your computer. Please
note that the information mentioned here may not be
exactly the same with your computer as specification
is subject to change without notice or modifying this

manual.

Designed with an advanced modular architecture,
your Notebook PC also allows you for several levels
of customization and expansion that are previously

available only on desktop PCs.
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A.1 System Specification

PROCESSOR UNIT

e Intel Mobile Pentium III pPGA2/ Intel Mobile Celeron pPGA2

e Suppotts CPU clock speed above 900MHz for Pentium I11/750MHz for

Celeron

e  256KB integrated L2 cache for Pentium II1/128KB integrated L2 cache

for Celeron

SYSTEM MEMORY

e Two 64-bit 144-pin memory slots

e  User-upgradable to maximum 256MB using 144-pin SODIMM 64MB,
128MB and module

e PC100 SDRAM modules

LCD DISPLAY

e XGA (1024x768) or SVGA (800x600) Color LCD

e  Maximum 16M true colors on all LCD display

VGA SYSTEM

e 2X AGP Local Bus VGA Accelerator (32-bit internal)

e  Simultaneous LCD and external monitor (CRT) display
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e  Maximum 16 million colors on CRT only display at 800x600 resolution
(Non-Interlaced)

e  Maximum 1024x768 resolution on CRT display at 16M colors

DiSK DRIVES

32-bit PCI Enhanced IDE interface with LBA mode

24X-speed Enhanced IDE bootable CD-ROM drive module

Built-in and user-upgradable 2.5-inch IDE hard drive

Optional DVD-ROM drive that can be replaced with CD-ROM

Optional CD-RM drive that can be replaced with CD-ROM

AUDIO SYSTEM

e Audio DJ plays audio CD without powering on the computer

e  Full-duplex 16-bit stereo audio with wavetable support and Plug-and-Play

features
e H/W Audio Sound Blaster 16 compatible
e  Built-in dual speakers
e Integrated full-duplex microphone
e Audio input jacks for microphone (MIC) and stereo device (Line-In)
e Audio output jack for external speaker or headphone (Line-Out)
e  FEarphone or headphone jack for audio output

e  Built-in Thumb Wheel Volume Control
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PCMCIA

e  32-bit CardBus PCI Local Bus PCMCIA controller

e  Double-deck PCMCIA slots supports 2 x Type 11 PC card at the same
time or 1 x Type III PC Card

e  Supports 32-bit Cardbus Cards, and 16-bit PC Cards

GLIDE PAD

o Integrated Glide Pad (PS/2 mouse) pointing device with left, right and

scrolling buttons.

KEYBOARD

e  Full-sized 86/87-keys keyboard with Windows 95/98 hot-keys, inverted
T-cursor keys, 7 hot keys, 12 function keys, and embedded numeric

keypad

e  Provides international language keyboard

Fr.AsH BIOS

e 512K Flash ROM BIOS for easy BIOS upgrade

I/0O PORTS

e 2 x Universal Serial Bus (USB)
e 1 x9-pin RS-232 Serial (COM1)
e 1 x 25-pin Parallel (LPT1)

e 1x15-pin VGA (CRT)

e 1 xIEEE 1394 port (option)
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e 1 x Bluetooth port (option)

INFRARED PORT

e 1 xIR port (option)

AC/DC POWER SUPPLY ADAPTER

e Universal auto-switching 60W (100V~240V) adapter

BATTERY

e  Rechargeable 8 Cells NiMH or Li-ion battery pack with Smart Battery

function
e 2~ 2.5 hours of usage (when run Battery Mark 4.0 diagnostic program)

e 2.5~ 3 hours quick charge (computer turn off)

WEIGHT AND DIMENSION

o 1217 (W) x 10.5” (D) x 1.41” (H)
e 6.6 1bs (Max Target)

A.2 IRQ Usage Summary

IRQ# Description

IRQ O System Timer
IRQ 1 Keyboard

IRQ 2 [Cascade]

TIRQ 3 LAN/MODEM
1IRQ 4 Serial Port 1

IRQ 5 Audio/VGA/USB
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A.3 DMA Channel Usage Summary

IRQ 6 Floppy Disk Drive

IRQ 7 Parallel Port

IRQ 8 RTC Alarm

IRQ 9 ACPI

TRQ10 LAN/MODEM/ PCMCIA card
TIRQ11 CARDBUS

IRQ12 PS/2 Mouse

IRQ13 FPU

TRQ14 Hard Disk Drive

IRQ15 CD-ROM or DVD-ROM

DMA Channel Device
DMA 0 MODEM
DMA 1 ECP
DMA 2 Floppy Disk
DMA 3 AUDIO
DMA 4 [Cascade]
DMA 5 Unused
DMA 6 Unused
DMA 7 Unused
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